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Introduction

PAGE is a tool which helps to create Python GUI interfaces using
Tkinter and the Tk/ttk widget set.  It is a rework or extension of the
program Visual Tcl (vTcl) which now produces Python code.

Faced with the problem of building a single GUI window for an
application, PAGE will facilitate designing that GUI window and
building a working skeletal Python program utilizing the Tk/ttk widget
set. As other windows are required, they are designed with PAGE and
incorporated into the application by importing the generated python
modules. See Applications with Multiple Top-Level Windows. Also, PAGE supports design rework to a limited extent.

PAGE is aimed at a user who wants to rapidly construct a GUI and is
willing to compromise generality for ease and speed of construction.
It is a helper tool. It does not build an entire application but
rather is aimed at building a single GUI window.  It is not a Python
Interactive Design Environment (IDE). Stated in other words, PAGE
generates a Python class which implements a single GUI window and also
supplies all of the boiler-plate code for execution or instantiation
of the GUI object. If, like me, you have difficulty remembering all
the little tricks of getting a GUI to show up on the screen, PAGE can
show you code that will work.

When I first set about building programs that exploited Tkinter, I
could not find nearly enough examples. Another way of looking at PAGE
is to consider it to be a Tkinter example builder which can build the
examples you need to see.  It is a good place to start when starting
with Tkinter.

The author is Donald Rozenberg and project page for PAGE is
http://page.sourceforge.net/. My email address is Don dot Rozenberg at
gmail dot com.


Change History

The 4.9 release fixes bugs related to state values of several
widgets. It also improves the Widget Tree by changing the labels to
display the class and the alias of the widget and automatically
updating it in more cases.

The 4.8.x releases fixes bugs and updates the documentation.

The 4.8 release includes support for Custom widgets which are widgets
for which the Python implementation is left to the user. Python 3
versions of the examples are included. The widgets handles have been
enlarged and colored to facilitate selection. Bugs related to the
changing of aliases have been corrected. Finally, a function which
expands a widget to fill its container has been added to some widgets
I have fixed some bug within the font handling code and that may
require that fonts in existing PAGE projects be re-specified.

The 4.7 release includes support for binding events to top level
windows and reorganizes the generated code for greater clarity and
provides variable parameter lists for the init function in the support
module using the Python convention of *vargs, **kwargs. Important
fixes for Cut, Copy, and Paste and for the TCombobox widget.

The 4.6 release includes new function. a) Shows generated code in
separate console windows. b) Allows loading of consol windows without
generating code. c) Allows the opening of user’s favorite IDE with
saved versions of the generated code. d) Corresponding changes in
the Gen_Python menu.

The 4.5 release incorporates new flexibility for the location of the
toplevel widget in the generated GUI using the default location
determined by the window manager.

The 4.4.x releases contain bug fixes.

The 4.4 releases supported popup or context menus. Also, support for
ttk menubuttons was removed pending more debugging and the Labelframe
widget was added. Finally, support for function definition was;
however, PAGE still defined skeleton functions as before.
The 4.3 release includes code to update an existing support module
with Tkinter variables and skeleton functions newly required as a result of
Rework.

The 4.2 releases has new function which aids Rework.  This is a
fairly extensive departure from the previous workings of
PAGE. Additional examples were added to illustrate some aspects of the
rework scheme. They also provided additional Help and additional
scrolled widgets.

The 4.1 releases contains several changes dealing with preferences
dealing with font preferences and function to backup versions of the
generated GUI.

The 4.0 release contains sufficient advances including:



	Significant improvements in the specification and clarity of Preferences.

	Significant work with color and associated connections with styles.  Emphasis on readability of generated style code. Unfortunately, this seems to work better with Linux/Unix systems than with Windows or OS X.

	Better support for OS X.

	Better support for the Scale and TScale widgets.

	Better support for Toplevel widgets. You can now change attributes; background and cursor, for example.

	Corrected problems with the TMenubutton.

	Shifted emphasis to Python 2.7 from 2.6.

	Added the ttk::sizegrip widget.

	Fixed numerous bugs.






The 3.0 release was a major revision of PAGE initiated because of the
following events:



	The release of Tcl/Tk 8.5 which includes the ttk widget
set. This is a themed widget set containing new core widgets
such as notebook, combobox, treeview and progressbar widgets.
Further, the themed feature allows the same design look natural
on Linux, Windows, and OS X.

	The advent of a new version of Visual Tcl upon which PAGE is
built. The new version provides an improved user interface.

	I have realized that some of the bells and whistles that I
included before are superfluous or perhaps error prone.

	Although relative placement was incorporated in the previous
version, it added to the desirability of making a major
revision because some Tix widgets had some problems when
stretched. I want to thank George Tellalov for his suggestions
and encouragement regarding this feature.

	The Pyttk package by Guilherme Polo showed me how to create
scrolled versions of text boxes and list boxes in a very
transparent manner.









X Concepts

Let me review some X window definitions and concepts in order to
avoid confusion with the terms used here, including top-level
window. Some of this information is taken from “Tcl and the Tk
Toolkit” by John K. Ousterhout. “The X Window System provides
facilities for manipulating windows on displays. ... Each screen
displays a hierarchical collection of rectangular windows, starting
with a ‘root window’ that covers the entire area of the screen. The
root window may have any number of child windows, each of which is
called a ‘top-level window’.  An X application typically manages
several top-level windows, one for each of the application’s major
panels and dialogs.” One can also speak of an application’s ‘root’
top-level window. This is the terminology from Grayson’s book. John
Grayson’s “Python and Tkinter Programming”, Manning, 2000




Visual Tcl

PAGE is based on Stewart Allen’s Visual Tcl program. In fact, it is
vTcl, with modifications and two additional modules that generates
Python code. And yes, it is written in Tcl! Why not? Tcl is a great
language to have available on your machine. It has features which I
would like to see in Python. There are many great programs written in
that language.  Further, it leaves the door open to use the same
techniques for GUI builders in other languages which support Tk. The
disadvantage of using a Tcl implementation is that one is restricted
to widget sets which are available to both Tcl and Python. In previous
versions of PAGE, I supported Tix widgets to provide a comprehensive
widget set. With the arrival of ttk widgets in Tcl/Tk 8.5, I felt that
the ttk widget set was sufficient and dropped Tix.

PAGE is a modified version of Visual Tcl. Visual Tcl is a interactive
Tcl/Tk program for generating whole projects in Tcl/Tk. Building PAGE, I
added the feature of also generating a Python program which realizes
the same GUI.  My changes were primarily to:


	Add the modules which generate Python code.

	Add support to Visual Tcl for the ttk widget set as well as scrolled
versions of several widgets like listbox, textbox, and treeview.

	Aim the program to handle only one top level window.  I ditched
the whole window project orientation. Facilities for testing Tcl
programs, for defining functions, and support for multiple toplevel
windows, and support for geometry managers other than the placer
geometry manager were among those deleted.

	Simplify the interface to only support the needs of one
building Python interfaces.

	Write some documentation and comments for the program.
Documentation of Virtual Tcl is virtually nonexistent and that is
truly sad but all too common with open source programming.



My changes have become so numerous that it is perhaps wrong to call it
merely a modification of Virtual Tcl.  I rather have begun thinking of
it as a fork which will probably be of little interest to the
maintainers of Vtcl nor should they be saddled with any responsibility
for the state of my version.  Since I have diverged so much from
Visual Tcl, I have decided to replace the Visual Tcl splash screen.

I was looking at different GUI generators for Tcl/Tk with a view of
converting the output of one to Python when I came across Visual Tcl
and the work of Constantin Teodorescu in generating Java from Visual
Tcl. I thought if one could automatically generate Java, it should be
even easier and much better to generate Python.

I believe that Stewart Allen wrote Visual Tcl in the 1996-1998 time
period to aid in the development of Tcl/Tk applications. Constantin
Teodorescu modified vTcl to generate Java code using SWING as the
widget set. Looking at the Java generator convinced me to try doing
PAGE.  I was able to discern its behavior in spite of the nearly total
lack of documentation, usually finding an existing procedure when
needed.

PAGE supports only the placer geometry manager. In the past, I
worked with Visual Basic and the placer geometry manager seemed
comfortable and got me useful results. Similarly,
Constantin Teodorescu also limited the Java generation to the placer
geometry manager. It seems really natural with the drag and drop
paradigm. One disadvantage is that some of the sizes could be wrong if
fonts change. This is because several Tk widgets have sizing based on
font parameters. This has implications if the GUI is generated with
different fonts or resolution than are active during execution. There
may also be similar problems if the generated GUI is moved to other
platforms or environments.




Design Paradigm using PAGE

The PAGE view of the application development process is to build the
program one GUI window at a time using PAGE to automate the
construction of the GUI window realized in the GUI module and to put
all of the supporting application dependent code in a support module.
I expect to change the GUI often as I polish its appearance and add
widgets, but ideally would only automatically generate the support
module once. The difficult coding job should be restricted to getting
the application right and not to realizing the conventions of Tkinter.
In other words, reworking the GUI appearance should have only a
minimum impact on the application code.

PAGE generates a single Toplevel window for use in an application.
n doing that, PAGE generates two Python modules, the GUI module and the
support module while preserving the design in the project file.

The orthodox view of object oriented programming groups all of the
attributes and methods of an object into a single class. I normally
follow that dictum.  PAGE deviates from that rule in that it places
the automatically generated code in a GUI module and expects the
hand-coded event functions to be in a separate support module. All
that PAGE does with the support module is optionally create a skeletal
version of that module containing linkages between the two modules and
skeleton callback functions. PAGE also can update the support module
to the extend of adding skeletons for new callback functions.

The separation of the two module results from requiring a
fool proof method for reworking the GUI.  I have found that I am constantly
changing the GUI for reasons such as improving its appearance,
clarifying its behavior, adding new widgets to support new function,
etc.; I call this rework.  Once I have researched and written code for
the support module, I don’t want to expose that code to some “smart”
automation program, even my own, but I still want to use PAGE to
update the GUI. Implementing rework requires that PAGE be able to
distinguish between automatically generated code, which can be
rewritten, and hand written code which must be left alone.  The only
safe way I could think to do that was to separate the code into two
modules. A paramount requirement of PAGE is the
preservation of manual code as the user goes around the loop of
polishing the GUI design and expanding and testing the application.

When building a multiple top-level window application, I recommend
that one use PAGE to build the ‘root’ top-level window and then use
the corresponding generated Python module as the the main
module of the application. When one needs additional top-level
windows, use PAGE to specify them and use that code as additional
modules for the application which can be imported as needed. (Generated
GUI modules will contain automatically generated functions to aid in
creating and destroying them within the modules.)

The GUI module contains code to actually cause the GUI to appear on
the screen. By interacting with the GUI, the user causes events, such
as selecting a button or adding text to an entry, to occur which
really invoke callback functions which are implemented as functions
found in the support module.

A design goal of PAGE is to allow the user to actually execute and see
the GUI before the application is completed. To that end, generation
of the support module will provide skeletal functions for the callback
functions.

When one does a save in PAGE, it saves the design as a tcl
file which then can be used as an argument to PAGE allowing one to
modify or augment the GUI. Even more important, if PAGE screws up it
can be used to restart the process at the point where the GUI was
saved. So, save often.  The Tcl GUI design file is not an executable
stand-alone script.  It contains Tcl/Tk code and is used as the
argument of the tcl source command.

The following diagram shows the design/implementation loop supported
by PAGE.

[image: _images/paradigm.png]
PAGE generates the three files shown above. The two modules on the left
are required to realize the GUI window as a Python program. The GUI
module as conceived by the author is completely generated by PAGE while
the support module will contain all of the hand coded Python required by
the application using the GUI window.

The project file records the GUI window description in the form of a
Tcl/Tk module. It serves as input to PAGE for subsequent rework
iterations. It is not an executable program.

Every time you make a set of modifications to the GUI design, you will
want to generate and test a new GUI module. However, the support
module needs to be changed only when GUI modifications refer to new
callback functions. There are a couple of additional but infrequent
cases as well. (They include the addition of Tkinter variables used by
widgets such as Label and a definition of a custom widget.)

The dashed line is meant to convey the idea that you will not want to
change the support module each time the GUI design is modified. For
that reason PAGE has separate commands for generating the GUI module
and the support module.  Also, the generation of the GUI module has
two variations, complete generation and updating the support module.

The first time that a GUI is designed, one wants to generate both
Python modules. The support module will have all the necessary boiler
plate necessary to work with the GUI module; i.e., the GUI module and
the support module should be an executable program even with no manual
code added to the skeletal callback functions.

With subsequent modifications of the GUI, the support module may need
to be updated by PAGE only to add skeletal functions for newly
referenced callbacks, etc. in the GUI.  No code is deleted. Further,
backup versions of all generated files are saved.

Please see Rework for more discussion of this world view.




A Very Short Description of using PAGE

[image: _images/page-simple.png]
There are three generated files associated with a PAGE GUI.  They are
a GUI design module, a Python GUI module which contains generated
Python code for instantiating a class which displays the defined GUI,
and a Python support module which is a skeleton for the code written
outside of PAGE which realizes the function of the GUI. The GUI module
and the support module can be executed from within PAGE to demonstrate
the GUI.

Using a drag-and-drop paradigm inspired by that of Visual Basic, one
constructs or designs the GUI window from Tk widgets within a top
level window and modifies the attributes appropriately, when satisfied
the user then issues commands to create the GUI module and the support
module. Those modules are displayed and may be saved and executed to
verify the appearance of the GUI. The remaining step of writing the
necessary code in the support module to realize the function or
application behavior of the GUI is left to the user.  The rest of this
document will expand and exemplify the first two steps of this
process.

PAGE generates two Python modules from a GUI specification.  The first
module, called the GUI module, is the code to create the GUI and is
named <name>.py. All the code in this module is generated by PAGE. The
other module, termed the support module, named <name>_support.py
contains the code that is necessary to complete the function of the
GUI.  As generated it contains skeleton code for the callback
functions named in the course of laying out the GUI, the definitions
of required Tkinter Variable classes referred to in the GUI, a default
definition of a custom widget, and finally the necessary linkage
between the two modules. The GUI design specification is captured and
saved for later use in reworking or modifying the design in the file
named <name>.tcl.

A user begins by invoking PAGE using a script, ‘page’ in linux.  You
get a new toplevel widget by selecting Toplevel in the Widget Toolbar
with Button-1. This toplevel widget is the GUI window. (In this
manual, I use the terms Button-1 and Button-3 rather than left button
and right button because a user may be using a left handed mouse. This
is consistent with Tcl documentation. Button-1 is under the index
finger.)


	Using Button-1 on the mouse, drag the toplevel window to where you
want it and resize it appropriately. Change attributes such as
title as desired using the attribute editor. If the “default
origin” is YES then the generated window will be placed at the
default location as determined by the system window manager,
otherwise it will use the coordinates of the current toplevel
location.



	Select a desired widget from the Widget Toolbar with Button-1 and
place it within its parent by clicking Button-1 within the
parent. One can then use the mouse to move and resize the widget
(For some of the complex widgets, one has to press the control key
along with Button-1 to select the entire widget.) Using the
Attribute Editor, then change any of the attributes of the widget
including the names of callback functions. It is probably a good
idea to provide an alias which will make the generated code easier
to read.



	Repeat the above step (2) until the GUI is complete.



	The remaining step is to generate the Python code in new python
modules with the same root name based on the root name the “tcl”
file. This is done by selecting commands ‘Gen_Python’ in the
submenu in the menu bar of the main window and generating the
Python code. Two Python modules are required the Python module for the
Python GUI and the Python support module containing callback
functions, etc.. First generate the GUI module, you will see a new
window, the Python console, where the code can be expected to
appear. After saving the GUI module, generate the support module;
generation is dependent on the save GUI module. Another Python
console will appear containing the support module. Again save the
module. Execute the code, to preview the GUI. It only shows the
GUI, it is not the complete application; you have to write that.



	Create the necessary Python functions to realize the function of
the application.  PAGE will facilitate this by generating skeleton
functions for any functions named as callback functions in command
attributes. The second python module with the same rootname with
“_support” appended is also generated from the “Gen_Python” item in
the main menu. It will contain skeleton functions named as
callbacks in the GUI and definitions for Tkinter variables also
referenced in the GUI.

As of version 4.6, PAGE can directly open an IDE such as idleX with
two windows containing the stored version of the GUI and support
module respectively. I want to avoid building an IDE.



	Test the GUI, this can be done by selecting the “Run” button in
either of the PAGE consoles.
This will show the resulting GUI.





With some Tk widgets, variables can be used to track changes to the
entered value. The Checkbutton and Radiobutton widgets require
variables to work properly. Variables can also be used to validate the
contents of an entry widget, and to change the text in label
widgets. When using those widgets in Python-Tkinker programs it is
necessary to use “Tk Variable Classes” - BooleanVar, DoubleVar,
IntVar, and StringVar - which create variable wrappers that can be
used wherever Tk can use a traced Tcl variable. In this document I
refer to these classes as “Tkinter variables”. PAGE assists by
creating the definitions for the Tkinter variables as well as
instantiating the classes. See effbot website [http://effbot.org/tkinterbook/variable.htm] for additional
information.  PAGE attempts to help by supplying boiler plate to
define and instantiate the required classes.

When the GUI code is saved or the File->Save is invoked, a Tcl design file is
saved so that one can come back and modify the GUI. As of version 4.2
with its emphasis on rework, PAGE creates a supporting module
containing the skeleton functions, required Tkinter variables, and the
required linkages. See Rework for details.




Status of PAGE

PAGE supports many of the Tk widgets and many of the ttk widgets, other
widgets seem to be of lower priority to me; creating scrollbars and
linking them with text boxes and the like seemed to be confusing so I
skipped them in favor of auto-scrolled widgets like scrolled list box,
scrolled text box, and scrolled tree. Though not directly implemented in
the ttk widget set, Guilherme Polo in his Pyttk samples shows how to
easily implement them; they seem great, therefore, they are included.

The supported widgets:


	Tk Widgets



	Toplevel

	Button

	Canvas

	Checkbox

	Entry

	Frame

	Labelframe

	Listbox

	Message

	Popupmenu

	Radiobutton

	Scale

	Spinbox

	Text








	Themed Widgets



	TButton

	TCombobox

	TEntry

	TFrame

	TLabel

	TLabelframe

	TMenubutton

	TNotebook

	TPanedwindow

	TProgressbar

	TRadiobutton

	TScale

	TSizegrip








	Scrolled widgets.



	Scrolledentry

	Scrolledlistbox

	Scrolledtext

	Scrolledtreeview

	Custom










I have included Canvas in the above lists; however, I have rarely used
the canvas widget directly and do not fully understand its use or
programming. I am concerned that its programming is so general that I
cannot usefully help with PAGE.  It is there and Page will manipulate a
canvas widget into your GUI.

With version 4.8, I have include the Custom widget, which allows the
user to include his own special widget, provided that he has a
Python/Tkinter implementation. See Custom Widget. I added this
feature because I want to use PAGE to build a photo album application
where I need a scrolling window for displaying photo thumbnail
images. I was able to find several such tkinter classes but none that
I felt comfortable including as PAGE widgets for any of several
reasons such as:



	I don’t fully understand the code.

	There is not a corresponding tk implementation which would allow
me to incorporate it into Virtual Tcl functions like the
Attribute Editor.

	The one I actually use successfully is alleged to contain bugs.

	The generality of the widgets may be lacking.






So for users who have a tkinter widget that they want to use, I have
implemented the Custom widget which can be placed, sized, saved in the
generated tcl file, etc., while the tkinter implementation is added by
the user to the support module.  Again, any configuration properties
are not available to within PAGE but may be user-manipulated in the
support module. Further you can use only one custom widget type per
GUI window but you can have several instances of it.

One of the important features of the ttk widgets is the ability to
generate and modify themes.  Unfortunately, PAGE provides only
rudimentary facilities for manipulating themes. See a later section on
Styles and Themes.

As conceived Visual Tcl will save executable Tcl files which can be
opened from the file menu or specified as arguments. PAGE is trying to
generate Python code so the resulting Tcl/Tk design files are not
executable but they definitely can be saved and loaded into PAGE for
rework and backtracking to a previous state.

Knowing that I should have tested more, written more, and included
more widgets and more examples, I apologize.  If you come across bugs
or have comments please let me know and I will fix it if I can. I can
be reached at [don {dot} rozenberg {at} gmail {dot} com].  Please
report problems and suggestions to me, it is the best way to help PAGE
to be as good as it can be.  I have mainly developed PAGE on linux but
I have done some testing of PAGE on Windows XP and on a Mac using Snow
Leopard.

While it seems prudent to advise users to keep it simple, take a look
at examples/complex.py where I have paned windows nested inside pane
windows and a notebook nested inside a nested paned window.

For release 4.0, I spent about two months working with the “Theme”
part of ttk and have had only partial success.  I now believe that the
“Theme” part of ttk is really a very poor piece of software at all
levels - concept, implementation, and especially documentation. My
guess is if it had been well documented it would have been recognized
by even the author as junk. I find it hard to believe that the people
who control Tcl/Tk allowed it in the code base. I continue to support
ttk because of the paned window, notebook and treeview widgets.

With release 4.2, I have addressed the problem of rework, hopefully,
allowing easy tweaking of the GUI without jeopardizing custom coded
support functionality.  See Rework.

I am not happy with the menubutton support, I will revisit it in a
future release. So far I have not found it to be a useful widget in
any of the GUI’s that I have created; I would appreciate comments about
that.




Installation

The required packages for executing PAGE are:



	PAGE 4.8 or greater - This is the GUI generator. Actually one
should be using the latest version. 4.6 or greater.

	Tcl/Tk 8.6 or greater. - I am using Tcl/Tk 8.6.4. Tcl/Tk is
required for executing PAGE. Tcl/Tk is required because PAGE is
written in Tcl/Tk.






Even though Python executes the tkinter interface to Tcl/Tk, a full
installation of Tcl/Tk is required to run PAGE. Many reported
problems, manifested in the message “unable to find wish” with PAGE
were resolved with the installation of Tcl/Tk.

The package required for executing the python code generated by PAGE is:



	Python 2.7 or greater. This version of Python includes the ttk
widget set.






One does not have to install Tcl/Tk or PAGE to execute programs
containing GUI’s generated by PAGE. All that is necessary is a Python
version which includes the ttk widgets.

Since Python 2.6 had its last release scheduled for October 2013, I am
now only supporting Python 2.7 which includes Pyttk.  I am also
recommending the most up-to-date ActiveTcl package.  I would recommend
that anyone using a package you generate with PAGE be instructed to
use Python 2.7 or 3.2 or later.

The installations that I am using place the directory containing PAGE,
named “page” into the users home directory.  This directory contains
the script “page”, which is executed to invoke PAGE.  The script
“page” is altered to reflect the locations of “wish” the Tk
interpreter, and the location of the PAGE directory.  This alteration
can be performed manually or by execution the “configure” script in
the PAGE directory.

The package contains the file “configure” which when executed on a
UNIX-like OS such as UNIX, Linux, OS X, etc.  will
create “page” a script for executing PAGE.  It is executed in the page
directory and its function is to:


	Determine the full path for wish (first trying for wish8.6 and then
wish8.5) and embedding that path as a variable in the page script.

	Setting the full path of the page directory as a variable in the page script.



If it completes setting up both one can then copy the page script
anywhere in the file system and execute it.  It looks in just a few
places for wish and so may not find where you have installed it. It
does look in the default location for ActiveTcl-8.6
(/opt/ActiveTcl-8.6/bin). If it fails to find a version of wish that
has been installed on your system, then manually edit the page script.

With the release of PAGE 4.0, it is necessary to remove any ”.pagerc”
which you may have because the new preference code may not work with
a ”.pagerc” created with an older version.  Also, existing ”.tcl” file
created with an older version of PAGE may not work.  At this point,
the release of version 4.0, I will only entertain bug reports which
can be recreated using Python 2.7, Tcl/Tk version 8.6, and PAGE 4.0+.


Installation on Linux

I am now running Mint 17 which including Python 2.7.6 and for Tcl/Tk
8.6.2. I am using the ActiveTcl distribution for Tcl/Tk. This is what
I recommend. Current Linux distributions like Ubuntu and Mint include
Python 2.7 and Tcl/Tk 8.5.  So I have installed  ActiveTcl-8.6.1 on my
system.

In the past I have found that building and installing both Tcl and
Python from source was quick and straight forward.  Just install
Tcl/Tk before building Python.

If you need to install Tcl/Tk 8.6, a good source is the ActiveState
binaries for Tcl, which is what I am using.

The steps for installing PAGE are:


	Untar the distribution file in your home directory. You
can probably use ‘tar zxvf pageXXX.tgz. This will put all the
distribution in the subdirectory “page”.

	Run ”./configure” in the installation directory, it generates the
script “page” which can invoke PAGE.  You may want to insure that
the script “page” is in your execution path. If the script fails,
manually edit the version of the page script from the installation,
see configure command.

	Remove any ”.pagerc” file.






Installation on Windows

Installing PAGE under Windows is considerably easier than with early
versions.


	Obtain and install the most recent version of ActiveTcl; use the
8.6 version.

	Obtain from http://www.python.org the windows
installer for the most recent version of Python and install it.  If
you install 2.7 or later, or 3.1 or later you will be fine.

	Download page-4.x.x.exe and execute it.



winpage.bat is the analog to the “page” script mentioned
above. winpage.bat is a one line file containing:

start /min   wish.exe c:\page\page.tcl %1





With Version 4.2.2, it is now feasible to install PAGE in any
directory and have the icon start the program.  This has been tested
on Windows 7 running under VirtualBox.  The default directory for
installation is C:\page. If PAGE is installed in a different
directory then winpage.bat will have to be changed  to
reflect the that fact. For instance if it is installed in C:\x\y
then the winpage.bat should look like

start /min wish.exe C:\x\y\page.tcl %1





It was suggested by Pär Smårs that the generation of winpage.bat with
the correct installation directory should be done magically at
installation.  With version 4.8.7, I managed to do this.  Since I have
a deficient understanding of the Windows world, I decline trying to
update the path environmental variable.




Installation on OS X

I have not done much with PAGE on OS X.  However, several users,
including Kent Fox, have tried PAGE on OS X and have convinced me that
I should try to support PAGE on that system.  However, the
implementation of ttk with respect to color on OS X doesn’t seem very
satisfactory to me so I recommend sticking with default colors.


	Obtain and install the prerequisites, the most recent versions of
ActiveTcl and Python.

	Download page-4.x.x.tgz

	Double click on it to expand the zip file.

	Move the page folder to your home directory.

	Execute the configure file in the page folder.
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The PAGE Interface

This section discusses the menus and several of the windows in the
PAGE interface.  Again, the PAGE interface is a modified version of the
Visual Tcl interface.  It was modified because some of the original
facilities and features of Visual Tcl are inappropriate for PAGE or
because the Visual Tcl documentation is in such a sad state that I
cannot decipher them.

When PAGE is executed initially, a number of windows are spread across
the screen in what may appear as random locations and sizes. I have
arranged them at the corners and the edges so that they will be out of
the way of the GUI you are building.  They should then be resized and
moved to more desirable locations.  Follow such placement with
Windows->Save Window Locations or File->Quit and the geometry of the
windows will be saved in the .pagerc file and used when PAGE is next
invoked.

Many PAGE parameters are are saved from one invocation of PAGE to the
next in the file “HOME/.pagerc”. Included are the preferences and the
geometry (size and location) of the various windows in the page
interface as described above. This file is saved when the user does
a quit.

Start PAGE by executing ‘page’ on Linux, winpage.bat in a DOS window,
or activating the PAGE icon on the Windows desktop. The page and
winpage.bat scripts may specify a filename. If the filename includes
an extension, it must be ”.tcl”; in the case of no extension or a
final ”.”, the extension ”.tcl” will be appended to the filename.

The user is then greeted with a number PAGE windows and the main menu.

The default interface for PAGE presents small font sizes and the Tk
default scheme of black on gray. So for my personal use I made the
fonts larger and wanted the background color Wheat. See the section on
Defaults and Preferences.

PAGE may be terminated with File->Quit which cleanly stops execution
while saving preferences and window geometry; Control-Q also quits
PAGE cleanly.


Menus

The main menu of PAGE contains some of the usual stuff and there is
nothing too surprising in the File, Edit, or Window menus.  There are
several PAGE windows which appear for various functions and the user
can relocate them and change their sizes with the mouse.  The Save
Window Locations item in the Window menu saves the current locations
for future invocations of PAGE. Quitting PAGE does so also.

The Widget menu is a context menu, a popup menu, providing functions
depending on the widget selected. The popup menu is activated by
selecting a widget from either the GUI window or the Widget Tree with
Button-3. It allows the invocation of things like the Menu editor, or
Page editor for the TNotebook widget. It also allows the user to do
stuff like cut, copy, paste, and delete the widget. A new facility in
4.8 is to expand a widget to fill its container. Finally, it opens the
Binding Editor. The top element of the popup menu selects a submenu
containing commands appropriate to the widget.

The Widget popup appears below:

[image: _images/widget-menu.png]
The Gen_Python menu creates the Python code for the GUI module as well
as the supporting module. It also loads existing modules into Python
Console windows or into a user specified IDE.

Finally, the Help menu opens an About window containing some
information about PAGE and can open the html version of the this
documentation in the default browser. This has been tested in Linux
with Firefox and Chrome, in OSX with Firefox and Safari, and XP with
Firefox (I don’t have a reasonable version of IE).

Let me emphasize that PAGE will contain bugs. So be sure to save
often. That is a purpose of the save commands in the File menu.

Many of interface elements like the Widget Toolbar, the Attribute
Editor, and the Widget Tree can be turned on from the Window item of
the main toolbar. Others are invoked from the widget menu after a
widget is selected.




Widget Toolbar

The Widget Toolbar is where one obtains widgets for inclusion in the
GUI. One begins building a GUI by selecting Toplevel with Button-1 and
a blank toplevel window appears on the screen.  To add widgets to the
toplevel, click on the widget in the toolbar and then click in the
parent.  The upper left hand corner of the widget appears at the spot
where the user clicked.

The Widget Toolbar appears below:

[image: _images/widget.png]
Clicking on the gray bands causes the corresponding section to
collapse or expand.




Attribute Editor

When one selects a widget the Attribute Editor displays all attributes
of that widget.  The plum colored fields are not writable the others
are. For instance, the Attribute Editor shown below allows one to
change the title from “New Toplevel 1” to something more
meaningful. That field is used to generate the Python
class name for the GUI.

[image: _images/attribute.jpg]
There is the Alias field which is writable by the user.  The user can
provide an alias to improve the readability of the generated code.








Widget Tree

The Widget Tree shows all of widgets created by PAGE and how they are
nested within their parent widgets, see below. The labels in the tree
show the widget class as well as the program alias used in the
generated Python code.

[image: _images/widget-tree.png]
The above tree shows that the selected widget is a Button nested in a
Frame that is the first tab of a TNotebook within the Toplevel window.
The alias which appears in the generated Python code for the Button is
Button3; the Frame, Second; the TNotebook, TNotebook1; and finally the
Toplevel window is implemented by the Python class - Special.

The Widget Tree is a very convenient place to select a widget with
Button-1 especially for selecting widgets within more complex widgets
like TNotebooks. I frequently use this window to select the widget I
want to modify and occasionally it fails to select the widget,
particularly when doing copy and paste operations.  For unknown
reasons, if I go and select another widget and then reselect the
widget I want, it usually works.

When you make a change which should appear in the Widget Tree, the Widget tree
may not be updated until you hit the update button in the upper left
of the Widget Tree. The number of such cases has been reduced.

As described below in the section Using PAGE, the Widget Tree is very
important when trying to move or select some of the more complex
widgets like paned windows or scrolled windows.




Bindings Window

This window which appears when Bindings is selected from the Widget
menu allows one to add an event one of the possible bindings shown for
the widget and to specify the associated action.  In the image below
the event <Button-2> has been added for a Button widget and
“button_handler2” is specified for the action.

[image: _images/button-bind.png]



Menu Editor

This window easily builds a menu.  You can see below an example of its
use.

[image: _images/menu.jpg]
It is called forth from the Widget menus or from the Attribute
editor. I made the selected menu entry with weird colors and fonts to
confirm that such is possible.




Preferences Window

The Preferences Window allows one to set some PAGE preferences.
I considered removing the Preferences Window completely, but on
further thought I realized that the this is indeed a complex subject
involving preferences for both PAGE and the GUI generated by
page. Please see the section on         Defaults and Preferences.

The Colors tab of the Preferences Window is shown below:

[image: _images/colors.png]
In version 4.6, the IDE entry command has been added to support the
new function of opening the users favorite IDE with stored versions of
the GUI and support modules. You will notice that the example shows
the full path of the IdleX.

The Basics tab of the Preferences Window is shown below:

[image: _images/basics.png]



Python Console

When the user generates Python for either the GUI module or the
support module as described above, a separate Python Console window
appears with the generated code inside the upper text box. Thus one
can see both the GUI module and the support module side by side as of
version 4.6.

The Python Console has the following appearance:

[image: _images/console.jpg]
The upper text box contains the generated text with a bit of
colorization applied; it is editable. The lower text box contains any
generated output from running the source program. The Python Console
is a ttk::panedwindow which allows one to move the sash between the
two text boxes.

To execute the generated Python module, just click on the Run button
of the ‘Python console’.  Unless you have written the necessary
functions not much will happen other than providing a preview of the
GUI. The skeletal functions that are generated automatically for
callbacks print the function name in the Execution Output window using
the Print function.  On Linux or OS X the function name will appear
immediately in the execution window; on Windows, when execution is
terminated.  The Print function works fine for Python 2.7 or 3.x. See
the penultimate paragraph of this section which discusses this
more. As explained in the  Rework section, the GUI module will
not execute unless there is a existing support module. If the GUI code
has been modified to include new callbacks then one shouldn’t expect
the GUI code to execute until those callbacks have been incorporated
in the support module.

There are several buttons along the bottom of the window. They behave
as follows:


	Save - Saves the contents of the upper text box into a file. It also saves the tcl file.

	Run - Attempts to execute the GUI source module even if the displayed code is the Python support module. It also may save the Python and the tcl file. The shortcut for run is <Control-r>.

	Close - Closes the Python console.  The shortcut is <Control-w>.



The upper text box can be modified (edited) by selecting a character
position with the mouse and typing. Such changes will be saved with
either the Save or Run buttons.

As you can imagine the colorization is not fancy. Keywords, comments,
and strings are set to distinct colors. The defaults are set to
reasonable colors for light backgrounds. One place you may have
trouble is with quotes that bracketed by ‘’’ or “””. You should start
a line with one of these delimiters and end a following line with one.

The Run Button attempts a trial run on your GUI. If you have enough
skeleton functions in the support module and there are no errors in
the generated code, you should see the python code executed and the
GUI window will appear. From there you close the Python window go back
to PAGE and refine the GUI by moving widgets around, adding additional
widgets, or changing attributes.

A problem was reported when users attempt to resize the window. Recent
changes allow the window to gracefully resize. This can be necessary
if the screen resolution will not allow the entire window to be
displayed. When the window is made smaller, it may appear to loose the
Execution pane. However, it can be recovered by moving up the sash of
the paned window.  When one quits and restarts PAGE after resizing the
Python console, the new size will have been saved in ~/.pagerc and
used when subsequently invoking the Python console including the
placement of the sash. So invoke the Python console, resize it,
re-position the sash quit PAGE, and restart PAGE to use the new Python
console.

Also, scroll wheel support in the Python console works.  To use the
scroll wheel in Windows one must focus on the desired pane
first. Finally, when the Python Console is in focus, Control-P and
Control-U will have the effect of generating the GUI module and the
supporting module respectively.

Execution of the python module on Linux communicates with the console
through pipes; thus output from the execution now appears immediately
in the Execution Output pane.  Coupled with a recent change which
embeds a print statement in the generated dummy functions, if a user
specifies a command for a button, for example, and generates the
python and runs it from the Python Console, and selects the button,
the name of the command will appear in the Execution Console.  This is
useful because no output from selecting the widget means that you have
not defined a callback function. Unfortunately, on Windows the this
output does not appear until the execution terminates.  (I have not
been able to get Tcl pipes to work with Windows. I would appreciate
help or suggestions.)




Color Dialog

There are many cases where when setting preferences in the Preferences
window or attributes for a widget in the Attribute Editor one selects
a little button with an ellipsis and the invokes a color dialog window:

[image: _images/colorpicker.png]
When this window pops up you are given several different ways of
selecting a color:


	Pick a color in the multicolored window with your mouse.

	Enter values in the Red, Green, and Blue entry fields.

	Enter an Hex color value such as #f5deb3 in the Color entry field. That is the color wheat.

	Enter a color name such as wheat in the Color entry field.






Colors

Since PAGE is aimed at using ttk widgets which will obey the canned
themes which are basically black on gray, I want the background of
created windows to be gray.  Unless you are prepared to work with
themes, I recommend that you stay with the tk default colors.




Dual Monitors

One user reported a problem involving dual monitors where he had
opened PAGE with dual monitors set up with the second monitor to the
right of the main monitor.  He then dragged one of the PAGE windows to
the monitor on the right.  Later he disconnected the second monitor
and reopened PAGE and was unable to see the window displayed on the
nonexistent monitor.  Version 4.8 attempts to fix this problem by
relocating the wayward window in its default position.  I have tested
this code in a Windows virtual machine but do not have the hardware to
test it on either Linux or OSX.  I would appreciate any information
from users using Dual monitors.
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Defaults and Preferences

Early in the development of PAGE, I considered dropping completely the
preference stuff derived from Virtual Tcl primarily because many of
the preferences were related to functions that do not have meaning for
PAGE.  However, I really disliked the gray background in PAGE and
wanted to change it to my favorite background color - wheat.  Also, I
felt that capability should be shared with the users. Having made that
decision, I saw that it was then a small step to consider allowing the user to
have one color scheme for running PAGE, while generating a Python GUI
with a different color scheme.  A similar progression of thoughts has
occurred with respect to fonts; it started because the default fonts
are too small for my elderly eyes.  So one thing leads to another and
it became a question of where to stop.  In version 4.0 I am
implementing color schemes consisting of foreground and background
colors as well as separate fonts for PAGE and the generated GUI.  I am
also trying to provide reasonable highlight coloring.  I try to
provide helpful information in the generated code so that you will be
able to see what I am trying to do and thus be able to customize your
results.

An addition argument for manipulating colors is that by
not exploiting colors, one is not really exploiting Tk. Not
really understanding ttk styles at all well, I ask that if you find
better ways or even a way of doing something which eludes me, please
let me know, I will be happy to use it, and secondly, hating to try
imposing my stylistic tastes, I again welcome comments.  Also let me
say, I have done most of my development and testing with light colors,
in particular the color wheat. That means that things can be expected
to work better with light colors.  I have also tested and tried to
make things work with a blue background and white foreground.

Let me clarify what is meant by defaults and preferences
here. Defaults are built-in attribute values which will be used for colors,
background and foreground, and font selection and sizes unless the
PAGE user sets them specifically for individual GUI widgets.  Defaults
also include colors and fonts to be used by PAGE in displaying its
interface
windows.
Preferences are user specified overrides for some of the attributes
used throughout by PAGE.
Individual widget attributes can be changed using the Attribute Editor.

Defaults can be derived from several sources.  First, if nothing else
is done, then the small gray world of Tk defaults prevail.  These
defaults may be overridden by values in the .pagerc file which was
saved from previous executions of PAGE where user preferences for the
default values were made and saved.  Those saved preferences can
always be respecified and saved.  The third source of overriding GUI
defaults comes into play when the PAGE user specifies or opens an
existing generated GUI ”.tcl” file. In that case the defaults for
further GUI development match those in effect when the file was saved.
That is, when you open up an existing GUI ”.tcl” for further
development PAGE will use the GUI defaults that were in effect at the
earlier time when the GUI was created, while PAGE ignores current
default settings. This third way is a version 4.0 enhancement.

Note that .pagrc is an editable text file; although I have edited it
on occasion, that should not be necessary and can cause problems -
that is what the Preferences Windows are for.

Confusion stems from at least two sources.  First, there is really two
sets of preferences, (1) those for the PAGE program, and (2) the
preferences to be used for the generated GUI.  Another source is that
there are multiple ways of specifying preferences within the Tk
environment. In the case of ttk widgets, one must use Themes and
Styles to manipulate colors and fonts but, unfortunately, there are a
number of aspects which are undocumented, complementing some serious
shortcomings in the implementation or design of the ttk code.  Through
experimentation and googling I have found some things that work. Once
again, I received tremendous help from Guilherme Polo in solving
important questions in my use of ttk styles. Even now there are some
disturbing artifacts in PAGE associated with my implementation. Again,
suggestions welcome.

There is no doubt, that things will be easier for the user if he
sticks with the defaults.  But then one is stuck with a dull gray
world with small print on Linux and Microsoft PC’s. (I think that the
Tk default gray is #d9d9d9 also known as the X11 color gray9.)

Lets start with the easy preferences. PAGE has several simple
preferences such as whether on not to use automatically generated
aliases or relative placement and the granularity of the grid upon which
a widget is placed. Those are easy and could even be dropped as user
settable options.  They were included when new features were added to
PAGE but now I am almost excursively sticking with the new features
and rarely test whether the older stuff still works correctly. So I
recommend that you stick with the initial settings.

Preferences are tougher in the case of the GUI because one is choosing
default values which may not be available to the user of the generated
application when the application is executed on a different operating
system from the development system. The same fonts and colors might
not be available on both systems.  You might accept some defaults with
respect to PAGE, but really want control over things like colors and
fonts to be used in your application.  I am doing my development work
on Linux and am oriented toward that operating system.

Finally, I have the question as to which defaults I set before you
have made any preferences known.  Although I do not like them, I have
set up PAGE to use Tk default colors and fonts. That is, PAGE uses as
the default background for ttk widgets - #d9d9d9. So select
File->Preferences and make the program behave best for you.

Note that when one makes changes in the Preferences, they are
committed when one selects the check mark in the upper right. At the
same time they are written to the .pagerc file to be utilized the next
time the user invokes PAGE.  If the user wants to abandon actions
taken in the Preferencs window, he selects the stylized “x” next to
the check and the whole window disappears and nothing is saved.  In
PAGE several variables derived from the preferences are set at the
initiation of the program. If you want to change preferences, I
definitely recommend opening PAGE, make your changes, save them by
selecting the check mark, and then exit PAGE.  When you restart they
should be in effect.

One gotcha remains.  If you start a project where you specified
one color scheme and saved the project in the GUI ”.tcl” file, then
changed a color or font preference and then reloaded the tcl file you
will find that the original color and font preferences are still in
effect; they are saved within the ”.tcl”. I repeat this because I have
been caught by it.

One further point is that you may run into problems when upgrading to
version 4.0 if you do not erase the ”.pagerc” file as part of the
installation.


Preferences Windows

When you go to File->Preferences in the main PAGE menu you bring up a
the Preferences notebook window with three pages.  The Basics page:

[image: _images/basics.png]
This page allows one to make several miscellaneous preference
choices. My recommendation is that they be left the way they
are. Relative placement and aliases are described elsewhere in this
document.




Color Preferences

[image: _images/colors.png]
The top section deals with colors displayed while executing PAGE. The
most important is the PAGE Background Color which is the background
color for all the PAGE windows. One makes a new selection by invoking
the Color Dialog by selecting the “Browse colors ...” button to
the right of the page. This open the Color Dialog and one can set the
color as described above.  To go back to the default color, select the
“Default Color” button.

The next row allows the user to set the foreground color, that is
necessary in case he selects a dark background such as dark blue.  In
that case, a light colored foreground color should be chosen.

In a similar vein, one wants a visible distinction for the widget tree
highlight.  That shows which widget has been chosen in the GUI under
construction.

For GUI colors, it is much the same as above.  I have not seen a
requirement for specifying a default highlight color.  If that is
necessary please let me know and I will see if I can implement it in a
future version.  I have wanted to have the menu in the top level
window be in a distinctive color band so I support that feature.




Font Preferences

[image: _images/fonts.png]
Since my eyes require large fonts like 16 point fonts, I can set the
PAGE default font which catches most of the right things.  For the
Python Console window I want a big bold font; that is the PAGE fixed
width font.

The GUI fonts are more numerous. In addition to the ones above, one
can specify the text font which is used in widgets like text boxes and
list boxes.  Again, I allow one to specify a menu font which is
different from the default.

One question I had related to the choice of fonts for text boxes.
Should the font be the text font or fixed width font?  If one wants to
build an editor in a text box as is the case with the PAGE Python
Console, then a fixed width font is desired, but if one wants to
display something like a help message then a variable width font is
more appropriate.  What I did for PAGE was use the GUI text font for
text boxes and the GUI fixed width font for list boxes.  In truth,
good arguments for using all three fonts for list boxes can be made.

Fonts have caused me much anguish and confusion.  One may pick a fonts
which works well on the system where PAGE is hosted.  Then one could
build a GUI which would call for specific fonts which are not
available on the target system. If you know what fonts are available
on the target system you can pick the fonts you like. Tk encapsulates
a set of standard fonts that are always available, and of course the
standard widgets use these fonts. This helps abstract away platform
differences.  The The predefined fonts are:



	TkDefaultFont    The default for all GUI items not otherwise specified.

	TkTextFont       Used for entry widgets, listboxes, etc.

	TkFixedFont      A standard fixed-width font.

	TkMenuFont       The font used for menu items.

	TkHeadingFont    The font typically used for column headings in lists and tables.

	TkCaptionFont    A font for window and dialog caption bars.

	TkSmallCaptionFont       A smaller caption font for subwindows or tool dialogs

	TkIconFont       A font for icon captions.

	TkTooltipFont    A font for tooltips.






The following python program (Python 2.7) will display the characteristics of the
default fonts:

import Tkinter
import tkFont

root = Tkinter.Tk()

fonts = tkFont.names()

for font in fonts:
    print "\n%s" % font
    config = root.tk.call("font", "configure", font)
    print config





It may also be the case that if a chosen font is not available on the
target system then one of these fonts may be used.  I can’t tell from
the documentation.  The preferences window allows one to specify the
default fonts used in the generated GUI. To avoid too much gilding of
the lily, I have allowed the user to specify the first four only. If
you try different fonts for one of the defaults and then want to
return to the true default such as TkFixedFont for the text widgets,specified
there is a button for that.  I have not provided for specifying
TkMenuFont for use in text widgets for instance.

You can specify a default font to be used and still specify different
non-default fonts for any individual widget. For instance, you can use
TkMenuFont for a Button widget if you want or in my case a 14 point
font.  There seems to be another weirdness in Tk to be avoided and
that is you can change the family, size, weight, etc. of the defaults
fonts; at least I have not made that easy.

If you are going to be using the GUI application on the system hosting
PAGE by all means select defaults that meet you requirements.  But
remember those fonts may not be there if the GUI executes on a
different system. In which case, the Tk will pick defaults for you and
that may not be what you want.

If a default font is active for a widget, it will appear in the
Attribute Editor with the default name such as TkMenuFont but if you
select the adjoining ellipsis key the font will be changed to a new
font with the characteristics specified by family, size, weight, etc..
That may not be what you want, in which case you can replace the font
name with the default font name.
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Module Structure

PAGE generates two modules, The GUI module, and the Support
Module. The first contains all of the Python code necessary to plop
the GUI window onto the computer screen. In my vision of the PAGE
word, the GUI module is not to be edited. It contains all of the
required linkage to the Support module.  It is generally the main
module of the application.

The Support module is generated in skeletal form and is the framework
upon which the application is built. It is where the user written code
resides.  As such it is infrequently generated or replaced by PAGE. In
fact, the separation is the secret of rework; it allows changes
to the content and appearance of the GUI window while preserving the
user’s code.


GUI Module

The main feature of the GUI module is the class definition, which
defines a GUI window.  It defines the top level window and all of the
contained widgets.  Note that it refers to all callback functions as
functions in the support module and that Tk variables such as
textvariables are referred to Tk variables in the support module.

The GUI module contains two stylized function for instantiating the
window class. They are:

def vp_start_gui():
        '''Starting point when module is the main routine.'''
    global val, w, root
    root = Tk()
    top = New_Toplevel_1 (root)
    fnew_support.init(root, top)
    root.mainloop()





which is the entry point when starting the routine as the main routine
of the application as seen at the bottom of the module:

if __name__ == '__main__':
   vp_start_gui()





The main thing about the function vp_start_gui  is that it initializes
Tk and establishes the Tkinter mainloop.   Note that the init function in
the support module is passed  pointer to the GUI window class.

and

def create_New_Toplevel_1(root, *args, **kwargs):
    '''Starting point when module is imported by another
    program.'''
    global w, w_win, rt
    rt = root
    w = Toplevel (root)
    top = New_Toplevel_1 (w)
    fnew_support.init(w, top, *args, **kwargs)
    return (w, top)





which is the entry point when ate GUI window is invoked from code
within the running application.  For instance, A secondary GUI such as
a progress bar is desired for some action triggered in the main
GUI. Notice that it does not call Tk() nor start a mainloop; you only
want one of those.  A big point is that the init function is passed a
variable argument list in the name of flexibility.  It is also passed
a pointer to the GUI window. This is done so that the user can close
the created window in its support module without closing affecting
other windows in the application.




Support Module

This module is home of the hand coded portion of the application.
Obviously, PAGE can only prepare a framework for the application. What
PAGE knows about are, (1) the linkage between the GUI module and the
support module, (2) the callback functions to be located in the
Support module, and (3) the Tk variables which are to be manipulated
in the support module.

For linkage between the modules is mainly the init function.

def init(top, gui, *args, **kwargs):
        global w, top_level, root
    w = gui
    top_level = top
    root = top





Here PAGE merely generates the bare minimum. It sets global variables
which refer to the root of the GUI window “root = top” and w which
points to the GUI window.  The latter allow the user to change
configuration of the GUI window and of widget contained in the
window. For instance if there is a button (Button1) in the GUI
window, the color may be changed anywhere in the support module simply
with the following code:

w.Button1.configure(color='red')





Also, if there is hierarchy of modules or routines flowing from the
support module, then the reference to the GUI window can be passed
along and manipulated.

The generated code for the callback functions is even simpler:

def callback():
    print('unknown_support.callback')
    sys.stdout.flush()





Code generated for the Tk variable kkkk looks like:

def set_Tk_var():
   # These are Tk variables used passed to Tkinter and must be
   # defined before the widgets using them are created.
   global kkkk
   kkkk = StringVar()





The code generated as above is so generated so that the GUI module and
the support module will be an executable pair.  That is, you can
execute the GUI module and see what it will look like even though you
have put in no additional application code. If the GUI invokes a
callback, say by a button select, the program will tell you that it
was invoked. Now you have a leg up, go program.

What if after you have written a substantial body of application code,
and discover that you need an additional widget in the GUI module;
what to do?

First invoke PAGE with the project name, add the widget with all its
configuration including callbacks and Tk variables. Then generate
Python code for the GUI module just like before.  You sure do not want
to rebuild the support module anew and erase all of your hand code.
So when you tell PAGE to generate your support module, it gives you
the option of updating the existing support module. If selected, PAGE
will merely add skeletons for the new callbacks and add the new Tk
variables.  In addition, it will backup the previous version of the
modules in case of failure or PAGE bugs. etc..  PAGE will keep backups
five deep.

As a convenience, the following code is added at the bottom of the
support module to aid in debugging.  I you are debugging the support
module and want to test its execution, you can just execute it and it
will not start by invoking a functions within the support module but
rather the main function in the GUI module.  I found it particularly
useful since I do my development in emacs where I have a key binding
which will invoke python to execute the current buffer.

 if __name__ == '__main__':
import bind_example
bind_example.vp_start_gui()





Some of these features are further explored in Applications with Multiple Top-Level Windows.
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Styles and Themes

My understanding is that the motivation and attraction of ttk is that
one may compose a GUI and it will look “normal” when run in any of the
common OS’s - Linux, UNIX, Windows, or OS X.  But what I want to do is
be able to manipulate the Themes and Styles in a way that let the user
depart from the norm; I want to be able to escape from the “small gray
world of the normal appearance”.  Unfortunately, there seems to be
various ttk inconsistencies which thwart that objective.  This
section will discuss some of the barriers that I hit with ttk styles.

This is an area that remains confusing to me.  If one is interested
using a GUI color scheme different for the default gray for Linux and
MS, then one has to confront Styles.  I was unable to make much
progress until I received a great deal of help from Guilherme Polo
which got me to the point I am at now.  I am not sure that I have found a
particularly good way of achieving my results.  So I have tried to
make style commands as clear as possible so that the user can
understand what I have done and change it accordingly.  If a user
knows a better way of doing this please let me know and I shall try to
incorporate it in a future release.

My expectation of the whole style and theme business is that one GUI
program would give pleasing and consistent results when run on
different systems.  I am not sure that has been achieved, see my
example of two different examples run on different systems at the end
of this sections. Also, I expect the situation to work in the face of
different color schemes.

First I would like to automatically generate code for the user which
would follow his color scheme.
Consider the following code for a GUI window that contains a tabbed
notebook with a background color of wheat:

def __init__(self, master=None):
    _bgcolor = 'wheat'  # X11 color: #f5deb3
    _fgcolor = '#000000'  # X11 color: 'black'
    _compcolor = '#b2c9f4' # Closest X11 color: 'SlateGray2'
    _ana1color = '#eaf4b2' # Closest X11 color: '{pale goldenrod}'
    _ana2color = '#f4bcb2' # Closest X11 color: 'RosyBrown2'
    font10 = "-family {DejaVu Sans} -size 14 -weight normal -slant roman -underline 0 -overstrike 0"
    self.style = ttk.Style()
    if sys.platform == "win32":
        self.style.theme_use('winnative')
    self.style.configure('.',background=_bgcolor)
    self.style.configure('.',foreground=_fgcolor)
    self.style.configure('.',font=font10)
    self.style.map('.',background=
        [('selected', _compcolor), ('active',_ana2color)])
    master.configure(background=_bgcolor)


    self.style.configure('TNotebook.Tab',background=_bgcolor)
    self.style.configure('TNotebook.Tab',foreground=_fgcolor)
    self.style.map('TNotebook.Tab',background=
        [('selected', _compcolor), ('active',_ana2color)])
    self.TNotebook1 = ttk.Notebook(master)
    self.TNotebook1.place(relx=0.28,rely=0.16,relheight=0.51,relwidth=0.5)
    self.TNotebook1.configure(width=300)
    self.TNotebook1.configure(takefocus="")
    self.TNotebook1_pg0 = ttk.Frame(self.TNotebook1)
    self.TNotebook1.add(self.TNotebook1_pg0, padding=3)
    self.TNotebook1.tab(0, text="Page 1",underline="-1",)
    self.TNotebook1_pg1 = ttk.Frame(self.TNotebook1)
    self.TNotebook1.add(self.TNotebook1_pg1, padding=3)
    self.TNotebook1.tab(1, text="Page 2",underline="-1",)





The first group of statements in __init__define define the default GUI
colors and the default GUI fonts. These setting come directly from the
user’s preference choices. I added the comments to the color
statements so that the user would have a little clearer picture was to
what was going on.  Similarly, there are several different ways to
specify fonts and I think that the string format that I used may be
the clearest for the user to understand and modify.  The complementary
color and the two analog colors were calculated from algorithms found
on the net.  I have included as comments the names of the closest or
exact X11 color. Also, if the color is specified by the X11 name a
comment contains the hex vaue.

_bgcolor = 'wheat' # RGV value #f5deb3
_fgcolor = '#000000' # Closest X11 color: 'black'
_compcolor = '#b2c9f4' # Closest X11 color: 'SlateGray2'
_ana1color = '#eaf4b2' # Closest X11 color: '{pale goldenrod}'
_ana2color = '#f4bcb2' # Closest X11 color: 'RosyBrown2'
font10 = "-family {DejaVu Sans} -size 14 -weight normal -slant roman -underline 0 -overstrike 0"





The next group of statements obtain the ttk
style in use and set the background and foreground color defaults for
ttk as well as colors for highlight and active colors.

self.style = ttk.Style()
if sys.platform == "win32":
    self.style.theme_use('winnative')
self.style.configure('.',background=_bgcolor)
self.style.configure('.',foreground=_fgcolor)
self.style.configure('.',font=font10)
self.style.map('.',background=
    [('selected', _compcolor), ('active',_ana2color)])





This will handle most of the color setting for ttk but not all of
them.  I expected that all the style configuration in ttk would be
inherited from the ‘.’ object; that seems not to be the case. Notice
that the second and third lines of code above cause the “winnative”
theme to be used when the code is run under Windows.

The following fixes the background color of the Toplevel window.

top.configure(background=_bgcolor)
top.configure(highlightbackground="wheat")
top.configure(highlightcolor="black")





Since the tabbed notebook is in use, we encounter one of the ttk
“exceptions” - colors for notebook tabs.  Hence, the following code:

_compcolor = '#b2c9f4' # Closest X11 color: 'SlateGray2'
_ana1color = '#eaf4b2' # Closest X11 color: '{pale goldenrod}'
_ana2color = '#f4bcb2' # Closest X11 color: 'RosyBrown2'





I came across some code which purports to calculate the complement and
analogs of a color and used that to calculate the above colors.  I also
used similar code to translate the RGB coding to the name of the
closest X11 color so that the user can get some idea of the color and
easily change them if desired.

Next comes one of the special cases, note book tabs.  Here I have
specified background and foreground colors for the tabs since they are
not inherited from the ”.” ttk object.

self.style.configure('TNotebook.Tab',background=_bgcolor)
self.style.configure('TNotebook.Tab',foreground=_fgcolor)





and finally I make the color of the selected tab the complement of the
background color as defined above, and the color of the tab under the
mouse one of the analog colors from above.  This is sort of automating
the theme color selection and I really don’t want to do that.  It just
seemed necessary to compete the task.  I hope the user is able to
derive from the example, the changes he wishes to make.

self.style.map('TNotebook.Tab',background=
    [('selected', _compcolor), ('active',_ana2color)])





The above shows the code I added to make the notebook widget look
consistent. Similar tricks can be seen for treeview widgets,
scrollbars, labeled frames, etc.  Again, if you see better or clearer
ways of handling style components please let me know.

I did all of my development work on Linux.  As an illustration of the
same PAGE-generated GUI running under different systems, let me
present the following screens shots of vrex.py (vrex is one of the
examples discussed later in the examples section):

[image: _images/vrex-linux.png]
Above: Running vrex running on Linux.  This is what I built using PAGE
on Linux..

[image: _images/vrex-wine.png]
Above: Running vrex running on Wine. This is close except for the
enlarged font.

[image: _images/vrex-XP.PNG]
Above: Running vrex running on Windows XP.

[image: _images/vrex-XP-winnative.png]
Above: Running vrex running on Windows XP using the “winnative”
theme. This looks pretty good except for the background color in the
menubar and the sizegrep.

[image: _images/vrex-osx.jpg]
Above: Running vrex running on OS X.

As one can see there are differences in appearance but on the whole it
seems to work reasonable well for this example.  That is fortunate
because the main feature of the example is the use of paned windows
and scrolled text widgets and they are certainly important for GUI
building.

However, I created another GUI, named pptest.py which can be found in
the examples subdirectory, containing one each of TNotebook,
TButton, TRadiobutton, Tlabel, Label, and Button.  As you can see
below the results were not quite as good.

[image: _images/pptest-Linux.png]
Above: Running pptest running on Linux.

[image: _images/pptest-Wine.png]
Above: Running pptest running on Wine.

[image: _images/pptest-XP.png]
Above: Running pptest running on Windows XP.  This is rather weak
mainly because the backgrounds and foregrounds of the notebook tabs are
not correct. Actually if you run the example and select one of the
tabs you will not be able to see the foreground, it is white as it
should be, but the background is also white when it should be a dark
color. Also notice that the TButton, TRadiobutton, and the label all
have different background colors as does the background color of the
page frame.  This is unfortunate because while the TButton, and
TRadiobutton can be avoided, the notebook widget is important. I have
discovered that though unlisted in the documentation, there is an
“xptheme” which is used when running under XP and it appears less
satisfactory than the “winnative” theme also not mentioned in the
documentation.

[image: _images/pptest-XP-winnative.png]
Above: Running pptest on Windows XP while specifying “winnative” as the
theme. This one looks correct as far as the notebook widget is
concerned and that is a step ahead of the “xptheme” is concerned.

[image: _images/pptest-OSX.png]
Above: Running pptest running on OS X.  My judgment is that this is OK.

I am at a loss to understand what happened with XP pptest.py
example. Clearly something pretty subtle is happening with ttk
themes. I have not found any adequate documentation about themes and
styles that can help me puzzle this out. I did notice that the library
directory in the ActiveTcl distribution has an “xptheme” and
“winnative” themes which are not mentioned at all in documentation and
which may mean the ttk may behave differently under XP than under
other versions of MS windows. And we see such a difference between the
XP and Wine executions of this example and Vrex.

I concluded that it would be better if I generated code which forces
the “winnative” theme when the generated GUI is run on Windows.  It
seems preferable to me to have the sizegrip with an incorrect
background but a better rendering of the notebook widget than the
other way around.  Any comments, help, or suggestions will be very
welcome.

From the above and similar experiences, for my own use, I avoid ttk
widgets which are also implemented as tk widgets such as buttons,
labels, frames, checkboxs, and radiobuttons, because of the
inconsistencies of design, documentation and/or implementation but use
notebook, paned window, progress bar, and treeview, because of their
convenience. I intend to keep looking at the ttk problems and if I can
learn how to avoid them I will certainly do so.
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Using PAGE

PAGE is built upon the program Visual Tcl, but is different because of
differing objectives of the two programs.  Visual Tcl was conceived as
complete build environment for Tcl. It included facilities for
managing projects with multiple windows, creating of GUI’s, binding
actions with callback procedures, creating menus, writing functions,
and testing the application, all the while supporting many different
widget sets and several geometry managers. PAGE is limited to defining
a single GUI window using Tk and ttk widgets and the placer geometry
manager; there are better environments for building and debugging
Python programs once you have code for the GUI.

PAGE makes use of the Virtual Tcl facilities for creating a single GUI
window, assigning attributes to widgets, binding events to callback
procedures, and creating menus. PAGE also automatically generates
skeletal callback functions and supplies much of the boilerplate code
for running Tkinter.

When PAGE generates the code for a window, all of the code for causing
Python to create and map that window is generated - a Python class for
the toplevel window with all the code necessary to instantiate the
class (i. e., display the window), import statements, Tk mainloop and
initialization, a main procedure, etc.  Therefore, if you have
provided the skeletal callbacks the generated code is executable and
you can see just how the GUI will look in a Python environment. PAGE
even attempts to generate skeletal callbacks. As mentioned above the
generated code resides in two modules.

The generated code can be used as the skeleton for your application.
However, the generated GUI may be a secondary GUI and all that you
really want to do is instantiate the toplevel class, use support
functions implied within the GUI and possibly to destroy that window.
You can do that by importing the code as a module and invoking
functions within that module including automatically generated
functions for creation and destruction of the window. This will be
discussed in more detail later.

I often use the generated GUI classes as starting points for
customization. When you are not sure how to start or want to quickly
try out some GUI ideas, PAGE is very useful because it generates all of
the boilerplate necessary.

PAGE is invoked by executing the “page” script located in the page
directory. I go to that directory and issue the command:

./page [filename]





I preface the command with ”./” to be sure I am executing the page
script in the page directory. By including “page” in the PATH
environmental variable, one can work in any directory.

PAGE can be invoked with zero or one file names.  If supplied the file
name should have an extension of ”.tcl” and the file should exist.  If
another extension is supplied that is interpreted as an error and PAGE
terminates. If no extension is given in the file name or the file name
ends in ”.” , an extension of ”.tcl” is assumed by PAGE. If the file
cannot be found PAGE terminates because PAGE expects a file generated
by PAGE.  If a file name is specified, the file should be a tcl file
saved during a previous PAGE session; it will be opened as PAGE begins
executing as an alternative to File->Open for proceeding from a saved
PAGE session.  Near the top of a ”.tcl” design file created in PAGE
there is a comment containing version information and a timestamp. If
that version information is not present then PAGE will refuse to open
the file.

As you use PAGE to build a GUI, you can save the current state of the
GUI at any time from the File->Save of File->Save As menu.  In fact,
it is a good idea to save your status often in case PAGE fails or
dies.

I am sometimes exasperated in PAGE because so many functions can be
performed several ways.


Overview

This section attempts to describe the main functionality of PAGE when
building an application with a single root window. It will yield a
Python module which implements the application interface.

One uses PAGE to generate a GUI as follows:


	Start PAGE by executing “page” or activating the PAGE icon on
the Windows desktop. In Windows one may also start PAGE from the
command line by going to the installation directory and executing
winpage.bat.

	Create the new top window by selecting the
top left button in the widget toolbar.

	Drag the toplevel window to where you want it.

	Resize the toplevel window by dragging a handle at the corners or edges.

	Change the title by changing the title attribute in the Attribute Editor.

	Add a menu to the top level using the Menu Editor entered from
Widget->Edit Menu in the main menu.

	Drag appropriate widgets from the tool bar to the toplevel window or
other previously placed container widgets.

	As desired to make the generated code more readable, specify an
unique alias for the widget.

	Adjust properties of the widgets and the toplevel window as desired.
Some of those properties will include specification of functions to
support the GUI such as to load list box, or to respond to mouse
selection, etc. Included can be the specifications of event bindings.

	Use the function definition facilities to specify the necessary
functions and use the bind specification facilities to bind events to
functions.

	When the window has the appearance that you want, select
Gen_Python->Generate Support Module. A new window will appear and fill
with the skeleton functions and the definitions of the Tkinter variables.
Save the source window of the python console.

	Then select Gen_Python->Generate Python GUI from the main menu.  A
new window, a Python Console will open and fill with the Python
code, which I call the GUI module. To generate the support module
select Gen_Python->Generate Support Module, which creates and fills
another Python Console with the generated skeleton support module.

	You can save the code in  one or both of the Python modules and then
try executing the GUI module to see if you like what you have designed.






Placing and Modifying Widgets


Toplevel Geometry

PAGE generates a single Toplevel Tk window which is the users GUI for
his application. (One can have multiple GUI windows; see
Applications with Multiple Top-Level Windows.)
As elsewhere with Tk and PAGE, there is more than one way to specify
where the GUI window will appear on the application user’s
screen.

Prior to release 4.5, the PAGE user would select the Toplevel button
in the Widget Toolbar and a toplevel window would appear on the
screen. As well as filling in subwidgets the user could drag the
toplevel widget to the desired screen location and also could adjust
its size.  When the Python code was generated it would contain code
that would place the GUI at the exact spot specified.  If you had
placed it at pixel specification +1000+300, it would end up 1000
pixels from the upper left corner and 300 pixels down.

With version 4.5, the Python code generation addresses the toplevel
placement with a new attribute - “default origin”.

The “default origin” preference, if selected will cause the generated
Python GUI window to placed on the screen at the default location as
determined by the system window manager.  If false, the location will
be determined from where the toplevel window is placed in PAGE. The
default for the this attribute is false, but can be changed by means
of the Preferences mechanism. A default of false will cause PAGE to
behave as before. Unfortunately, I was faced with an unclear mnemonic
in the Attribute Editor or a double negative; I chose the latter.




Adding Widgets

All that is necessary to add a widget to the GUI is to select it with
Button-1 from the Widget Toolbar, position the cursor inside the
destination container and again press the Button-1.  A small version
of the widget will appear with its upper left-hand corner at the point
of the Button-1 click.




Aliases

Often algorithmically generated names can be difficult to understand
in computer generated code.  To reduce the problem in PAGE, users can
specify more easily understood names called aliases.

An alias is a user specified identifier of a widget in the generated
code. Obviously, aliases must be unique within the class which will be
generated in the python code to realize the GUI window.


	An easy way to specify an alias is to select the target widget with
a Button-3 click and then select “Set Alias ...”.  Another small
window will appear and one can add the alias. Finally close that
window by selecting the “check” or with the Enter key.

	Another way to enter an alias is to select a widget with Button-1
and then select “Set Alias ...” from the Option menu in the main
PAGE window.

	Also, one may specify an alias by selecting a widget and editing the
“Alias” field in the top section of the Attribute Editor.



An alias must be a legal python identifier.  PAGE does allow blanks
in an alias but they will be changed to “_”.  Also Alias has no
meaning for top level windows.  For top level windows the the variable
names are generated from the title attribute. There are numerous
schemes for generating such names but one that has been suggested is
based on CamelCase. It is:


	Buttons could start with ‘btn’,  i.e. btnQuit, btnNew, etc.

	Entry boxes could start with ‘txt’, i.e.  txtFirstName, etc.

	Check boxes could start with ‘chk’ I.E. chkDoThis, etc.

	Radio Buttons could start with ‘rdo’ or ‘rbtn’.



Note that PAGE has an option to automatically generate
aliases.  These aliases are algorithmically generated name but are
more readable than the default
generated names.  This is controlled by a new field in the Preference
window.  I recommend that you go
into Preferences, check the value and save the preferences.  Why the
original Visual Tcl program had two methods of generating names, one
comprehensible and one not, but chose the less readable one as
the default is baffling.




Selecting and Modifying a Widget

There are several ways to select a widget for modification and I don’t
want to keep repeating the variations through out this document.

For simple widgets like buttons or text boxes you can select the widget
either by selecting the widget with Button-1 in the GUI or in the
Widget Tree.

With more complex widgets like notebooks, paned windows, or scrolled
widgets, clicking Button-1 inside the widget will select a child
widget rather than the whole widget.  The widget may be selected with
Control-Button-1. Alternatively, the widget may be selected with
Button-1 in the Widget Tree. When dragging the widget or a handle hold
down the control key.

Once selected there are several ways to modify the widget.
:


	A selected widget may be moved by dragging the widget or resized by
dragging a handle. When the mouse is over a handle, it turns red.

	Attributes can be changed in the Attribute Editor. Geometric
attributes can be changed Attribute Editor also

	Some changes can be made using the Widget Menu.



If you are working with standard Tcl widgets, there are many options
that can be modified whereas the ttk widgets have very few options,
their appearance being governed principally by the specified theme.




Fill Container

“Fill Container” is a feature that was added in version 4.8 and causes
the selected widget to expand to fill its container provided that
there are no other widgets already in the container. This function is
restricted to those widgets for which I think it makes sense, like
frames, notebooks, scrolled widgets, canvases as well as text and list
boxes.

To use this feature activate the Widget popup menu with Button-3 over
the widget itself or an entry in the Widget Tree and select
“Fill Container” from the widget submenu.






Cut, Copy, and Paste

After much work I think that there is now a useful cut, copy, and
paste feature in PAGE.  The basic way it works:


	Select the widget you want to paste in a new spot or container by
selecting it as you would for just plain moving it.

	With Widget Menu and select with Button-1 Cut or Copy as you want.

	In the Widget Menu select Paste or use Control-V or select Paste
from the Main menu -> Edit.

	Move the mouse to the desired insertion point and click Button-1.



Copy and Paste are important features because one cannot drag a widget
from one container widget into another but one can cut or copy and
paste to get that effect.  For instance if one creates a button in a
top level window and then decides that it should be moved to a frame
or a notebook tab, that cannot be accomplished that just by selecting
the button and dragging it to the frame. However it can be done with
cut and paste.

When doing cut-copy-paste I make fewer mistakes by selecting the
widget the Widget Tree than trying to grab it in the top level window.
Correct selection is crucial important when trying to select and copy
nested widgets.

I have implemented cut and it appears to work; however, I never use
it. There is a sequence of several steps between the selecting copy
from the menu and selecting the location of the paste.  If you get it
wrong following a cut, you can’t go back and retry the operation; the
source for the copying is gone. So, I stick to copy and paste and then
finish with a delete.

One thing that cut, copy, and paste cannot do is copy from one
module’s GUI and paste in another module’s GUI.




Widget Menu

The Widget Menu, which appears in more than one place including the
main menu as well as the drop menu in the Widget Tree or a top level
window, provides a convenient way to modify some of the widget
attributes. The drop menu is activated with Button-3 applied to the
selected widget and its features are dependent on and apply to the
widget selected. It is seen below:

[image: _images/widget-menu.png]
In the case above the widget submenu allows one to easily specify the text
attribute and for specifying multiple line text labels.




Linking Events to Actions

I will not try to explain event binding fully for Tk and Tkinter. I have
read several books and many web pages on the subject but feel little
mastery.

The point of building a GUI is to link actions (the execution of
specific code) to some event within the GUI like selecting a button
with a mouse key, typing a particular character into a text field, or
resizing window a widget.
Binding events to widgets is a very confusing aspect of using Tk and
Tkinter.
Tk implements a global binding hierarchy in that
Tk allows one to create bindings between


	events and a particular widgets such mouse selection and a
particular button,

	events and particular classes of widgets such as mouse selection and
all buttons in an application,

	events and all widgets in a
toplevel window, and

	events and all the widgets in an
application.



PAGE really assists in only the first type of binding. At least one
respected documenter recommends against using the other three.

Grayson, in his book talks about invoking callbacks directly or
indirectly. Specifying a command attribute leads an indirect invocation
while specifying a bind command leads to a direct invocation. The
difference is that the direct invocation passes an event object to the
callback and the callback function must have an argument list which
includes a parameter for the event. To see examples of direct and
indirect invocation of callbacks see the vrex example or the bind example.
One could also characterize them as clear and confusing, or easy and complex.
Let me discuss the easy case first, that of specifying a a command attribute.

Many widgets have a command attribute which specifies the code to
executed when the widget is selected with Button-1.
This is a simplified way of binding for the common case of selecting
the widget with Button-1.
While
Tk allows one to specify a block of code, one must
stick with a function name in Python.
For example, setting the command attribute
of a button to “foo” so that selecting the button will cause the
invocation of the function “foo” with no arguments.

If you want to invoke a function and pass parameters to it, you use a
lambda expression. Please see section 6.4 of Grayson’s book for a fine
explanation of the use of lambda expressions in this context.
(In a nutshell, if Python see a function name followed by parenthesis
it will try to execute immediately, whereas the execution is desired
when the event occurs.)
Let say
that if you want to call the function foo and pass it 3 as an
argument, what you enter as command is

lambda : foo(3)





not

foo(3)





or to pass a variable parameter

lambda x: foo(x)





not

foo(x)





To specify such a command, one selects the widget and then in the
Attribute Editor enters the command in the Command field. In keeping
with the Virtual Tcl style of having too many ways of doing most things, an
alternative is to select the widget in the Widget Tree with Button-3
and then Widget->Set Command. I don’t use the alternate method very
often. I would probably forget it but for this paragraph.

So much for the binding of the easy case which essentially defines a
configuration command for setting the command attribute of a widget in
the generated Python.
For binding other events to widgets I point you to the Bindings Window
which essentially builds a bind command. Of course, the bind command
could be manually coded in init function of the support module.




Bindings Window

There are many events that can be linked to code. See the Tk man pages
and Chapter 6 of Grayson. They include responding to the different
mouse button pressings or releases, a window getting or loosing focus,
etc. as well as virtual events. Bind is the command for linking one of
these events to code and is accomplished by using the Bindings Window.
Here the code must be a lambda expression because it pass an event
object containing much useful information to the
callback. Consequently, the callback function must have an event
parameter in its argument list.

The Bindings Window can be opened by selecting the widget with
Button-3 and the selecting Bindings... from the popup menu. Basically,


	select the widget in the left column if not already selected,

	Insert the desired event from the Insert menu,

	select the item in the left column, and

	fill in prototype lambda expression in the right hand column.



The Bindings Window can be opened either from the popup menus in
response to selecting the widget with Button-3 or selecting the widget
with Button-1 and typing Alt-b. Then select Insert from the menu to
put the event in to the left pane.  Finally insert the desired code in
the right pane where a template will appear.

Let’s clarify that and look again at

[image: _images/binding.png]
In the left column you will see the Tcl name of the selected widget and
below the name a list, initially empty) of the events already bound to
the widget.  In the image two events have already been bound, one of
which is a user defined virtual event, “<<Bingo>>”.
Following the event information of the selected widget is a bunch of
information about the bind hierarchy related to the selected widget. I
have not found any use for that stuff.

Two things can be accomplished with the Binding Window are


	define a new binding for the selected widget The key action for
the first is to insert a new event. It is done by clicking Insert
Menu and selecting one of the actions there.

	modify the lambda expression of an existing binding in the obvious
way.



Selecting Insert yields

[image: _images/insert-bind.png]
If you do not find the action you can select Advanced ...

[image: _images/advanced-bind.png]
Here you are presented with a wide selection of possibilities.

First, if you want the event to be the pressing of the key c, select
the entry box at the top and type “c”; the event “<Key-c>” appears in
the Event entry box near the bottom. If you want to modify the event
to require the control key at the same time, select Control from the
right column and the event becomes “<Control-Key-c>”.

For events other than a key press event, then select an event from
the left column.  The list of events there is more or less every event
Tk knows about. I know of no way of listing only those events to which
a particular widget will respond, so I can’t prune the list.

Again, the selected event may be modified by picking a modifier from
the right column. Notice that the left column contains all of the
virtual events that Tk know about. If you are going to generate a new
virtual event, say <<Bingo>>, you can add that to the Event entry box
manually.

Having now composed your event, you can select the “Add” button
which will close the insert window and add the event to the left
column of the Binding Window.

The penultimate step is to appropriately change the skeletal code in
the right column. Basically, just add parameters and supply the
callback function name in place of “xxx”. Finally, save the result by
selecting the check button.  This is similar to the situation with the
command already discussed.

The big difference here is that the callback is always passed a
parameter, the event object, and so a lambda expression is needed to
pass that object or any parameters to the callback function.  This
means that the command for passing the event object (with no user
parameters) is:

lambda e: foo_bar(e)





or if passing user parameters:

lambda e: foo_bar(e,5)





Of course, if no parameters, not even the event object, is needed by
the callback function the following forms may be used:

lambda e: foo_bar()





or

foo_bar





The parameter e above is the event object which contains much
information about the event. The object has the following attributes
(from the documentation found in Tkinter.py):

serial - serial number of event
num - mouse button pressed (ButtonPress, ButtonRelease)
focus - whether the window has the focus (Enter, Leave)
height - height of the exposed window (Configure, Expose)
width - width of the exposed window (Configure, Expose)
keycode - keycode of the pressed key (KeyPress, KeyRelease)
state - state of the event as a number (ButtonPress, ButtonRelease,
                        Enter, KeyPress, KeyRelease,
                        Leave, Motion)
state - state as a string (Visibility)
time - when the event occurred
x - x-position of the mouse
y - y-position of the mouse
x_root - x-position of the mouse on the screen
         (ButtonPress, ButtonRelease, KeyPress, KeyRelease, Motion)
y_root - y-position of the mouse on the screen
         (ButtonPress, ButtonRelease, KeyPress, KeyRelease, Motion)
char - pressed character (KeyPress, KeyRelease)
send_event - see X/Windows documentation
keysym - keysym of the the event as a string (KeyPress, KeyRelease)
keysym_num - keysym of the event as a number (KeyPress, KeyRelease)
type - type of the event as a number
widget - widget in which the event occurred
delta - delta of wheel movement (MouseWheel)





A couple of points need mentioning. First, the Binding Window contains
a lot of cruft below the event entries for the selected widget which I
don’t understand and can’t use. It seems to be a listing default events for the
binding hierarchy of the widgets alluded to above. I am toying with
just removing it. In addition I have never done anything good with the
buttons below the menubar except for the check button. I might
dispense with them also. Stay tuned.

With version 4.8, Custom Widgets were introduced. Since PAGE knows
nothing of those widgets including binding possibilities, the
mechanism just described cannot be used to specified bindings for such
widgets. You will have to do that in the support module.




Specifying Fonts

When manipulating most widgets in PAGE, the user can specify fonts to
be used with that widget by means of the font field in the Attribute
Editor. If one selects the ellipsis button - the small button with
‘...’ - a font selection opens and its use is straight forward. One
may also add a font description in the entry field and that is where
restricted to using Tk font specification formats which are
exemplified below:

-adobe-courier-bold-r-*-*-20-*-*-*-*-*-*-*

{{deja Vu} 12 bold}

-family {DejaVu Sans} -size 12 -weight bold -slant roman -underline 0 -overstrike 0








Defining Functions

If you name a function in a menu, an event binding, command attribute,
etc., then definition of that function is required before trying to
execute the GUI in PAGE.

Executing the GUI means to execute the generated Python code within
PAGE to demonstrate how the GUI will appear in the completed
application by selecting the Run button on the Python Console.  To
satisfy requirements of the Python interpreter Tkinter variables and
callback functions have to
be defined. Skeleton functions will be satisfactory
since at that state of development you really don’t expect the
application to usefully function.

One path for the user is to do nothing, letting PAGE create a skeleton for
you by just noticing that the a name is specified in a binding or an
attribute in the support module as described in Rework.  This
is the recommended approach as of version 4.2.

I usually just let PAGE generate the skeleton functions, run the
resulting code to see what my window will look like and then do the
rest of my programming in emacs. When PAGE stores the python modules,
several layers of backup files are retained.  If I need to regress to
one of them, I find that Meld [http://meldmerge.org] is a
wonderful utility for managing the differences between versions.




Special Widget Processing


Toplevel Widget

Toplevel widgets don’t really have a title property. It was added in
Visual Tcl and the Attribute Editor originally displayed it as one of
the geometry attributes. That didn’t seem like a good place so I moved
it to the Attributes section.  The title is displayed at top of the
window and is used with “_“‘s replacing blanks, as the name of the
generated Python class.

It never occurred to me that a user might want a null title to a
toplevel window. However, one user tried that and reported a bug so
version 4.8.10 allows one to set the title field in the Attribute
Editor to null. The name of the class implementing a toplevel window
is based on the window title. So in the case of a null title, the
class name used is the alias specified for the toplevel widget.

Among the attributes listed for a toplevel widget is ‘menu’ which in
PAGE allows one to easily create  a menubar at the top
of the widget. Click on the attribute and follow the procedure below.

An improvement in version 3.5 was the ability to change other
properties such as the colors and the cursor of Toplevel widgets. One
property of Toplevel widgets is relief.  However, I was totally unable
to change that property at either the Python or Tcl/Tk level.  I
simply don’t know how.

With version 4.8.6, the Toplevel widget may be deleted by closing the
window in PAGE with the delete control button in the window title bar
or Alt-F4. Since only one Toplevel widget is allow in PAGE this has
the effect of restarting the design session.




Relative Placement

Following the paradigm I am familiar with from VB, PAGE uses the place
window manager to fix location within the generated GUI.  Thanks to
George Tellalov, who suggested using relative placement for widgets
within the GUI thus allowing one to build stretchable GUI’s.  They
allow one to grab an edge or corner of the executing Python GUI and
change its size and while maintaining relative positions and sizes of
the internal widgets. This is the default behavior. Keep in mind that
with relative placement, widgets may change size as the toplevel
window is resized, but fonts do not change size.

Since I don’t think buttons or labels should change size in step with
the change in size of the window, relative placement for buttons does
not change the size of buttons but the relative placement is
maintained.




Tkinter Variable Classes

With several of the widgets using variable to set or reflect values,
it is necessary to have linkage between tkinter variables and Python
variables.  For instance, when one moves a slider of a scale in the
GUI window, he wants the value to be reflected in a Python variable or
conversely changing that variable should change the position of the
slider. This is done by means of the Tkinter variable classes:
BooleanVar, DoubleVar, IntVar, and StringVar.

You need an instance of one of these classes. PAGE guesses the variable
type which you may need. You can then use the get method in Python to
determine the value of the variable in tk and use the set method to
set the value of the tk variable.  There are examples below.  For more
information see the Tkinter Variable Class [http://effbot.org/tkinterbook/variable.htm] on the effbot.org web
page.

For instance if you are using a TScale widget to be coupled with the
tk variable variable “val”:

def set_Tk_var():
    global val
    val = DoubleVar()
    val.set(5)   # Initial value to be displayed.





then you need to set the TScale attribute to “val”.  The rule is that
the Tkinter variable must exist before it the widget class is
instantiated. It may appear in the toplevel class definition like:

self.che26.configure(variable=self.var)





When val is changed

val.set(14)





the TScale will move to that value.

If the TScale is changed in the GUI, you can read the new value with

val.get()





PAGE tries to help out by generating an instance of the appropriate
global class variables as needed in the support module.  Again, this is skeletal code to
help the generated Python code run from within the Python Console. It
recognizes that a variable starting with “self.” is a class variable.
Again, I do not use these support variables because I think that the
generated Python is less clear.

For more discussion of Tkinter Variable Classes see Tkinter 8.5 reference [https://infohost.nmt.edu/tcc/help/pubs/tkinter/web/control-variables.html].




Ttk Widgets

There are some aspects of the ttk widget set that have presented me
with some significant difficulties mainly due to “styles”, it may
be merely that I don’t understand the ttk widgets well enough or to
problems with their implementation and documentations.  I will try to
explain my problems below. I would welcome any suggestions.




Scrolled Widgets

For some reason that I don’t understand, the Tk folks have never seen
fit to implement scrolled widgets such as a Scrolled Text widget. I
certainly don’t want to fuss around with all the separate programming
tasks required for build a scrolled text widget when building a GUI.

I am especially pleased that Guilherme Polo in his Pyttk-samples
package shows how to build Scrolledtext and Scrolledtreeview
widgets. Borrowing that code, I was able to include such widgets as
well as a Scrolledlistbox in PAGE.

One can select a scrolled widget from the Widget Toolbar and place it
in the GUI and PAGE will include all of the Python support coded
necessary to realize the scrolled widget. The scrolled widgets that I
added are not named with an T because they are not official ttk
widgets. The Scrolledtextbox has a normal text subwidget in which I
have chosen to make the “wrap” default “none”.

Although Polo implemented his code with ttk widgets, I have used his
ideas to implement scrolled tk widgets as well. In fact, where
possible I have used tk widgets in preference to ttk widgets. For
instance, I have based only the ScrolledTreeview and Scrolledcombobox
on ttk widgets. I am indebted to Polo for his ideas but he bears no
responsibility for any errors I make interpreting his ideas.

The scrolled widgets are compound widgets containing as-needed
scrollbars and an elementary widget. As such, to set attributes or
apply bindings, first select the elementary internal widget.

When the scrolled widgets are placed into a container window, the
image shown displays vertical scroll bars to facilitate
identification. The best is that the appearance is similar to that
which is shown when the GUI is executed because as implemented in the
Python code the scroll bars appear only when required. I had a lot of
trouble with background colors in the ttk::scrollbars used in the
Python GUI.

These widgets are complex widgets, so to move or resize them, use
Control with Button-1. The scrollbars are ttk::scrollbar widgets which
appear only when needed, i. e., when an item extends beyond the
allotted space.

When inserting text inside a Scrolledtext widget, treat it like a text
widget. For example, uses code like

obj = self.Scrolledtext1
obj.insert(END, "This is text to be inserted")





When  cutting, or copying scrolled widgets, I use the widget tree for
easily selecting the whole widget rather than just the interior widget.




Ttk Notebook

If you select, place, and resize a TNotebook in
your GUI window it will display two pages and look like:

[image: _images/notebook.jpg]
To change the attributes of the TNotebook, select the notebook editor either
by invoking Control-Button-1 in the widget and then selecting edit
page from the Widget menu or by selecting it in the Widget Tree with
Button-3 and then the Widget entry in the popup menu.

[image: _images/edit-pages.jpg]
Here you can do all sorts of interesting things like change the text
in the tab and select the tab you want to activate for adding widgets
or changing attributes of widgets already added to that page. If you
go to the menu Item->Add, it will create a new page to the
notebook, in the above example, between Page 1 and Page 2.  The Move
menu as well as the up and down buttons will change the order of the
pages.  The move operation will move the selected page one position up
or down.  The move is circular in the sense that moving the bottom
item down will move it to the top, etc..

Another way of navigating the pages is the pages attribute in the
Attribute Editor.




Ttk Panedwindow

The TPanedwindow can be added to the GUI by selecting it from the
Widget Toolbar and then Button-1 in the container.  There are two
entries for the TPainedwindow, one for vertical separators and another
for horizontal, in the Widget Toolbar.  It can be moved around by
Control-Button-1 and resized by dragging one of the handles. It is
sometimes a bit difficult grabbing a handle unless you select the
TPanedwindow widget from the Widget Tree window. Each pane of the
paned window contains a TLableframe which fills the pane.  Using the
label frame was the only way I could find to actually get the a
TPanedwindow to appear on my screen. Again, I had few examples to work
from.

The paned window is configured by invoking Widget->Edit Panes menu
item bringing up the following editor.

[image: _images/edit-panes.jpg]
This editor allows users to move among the panes, change the text in
the label frame, and to manipulate the position of the sash between
the current frame and the next one.    You can set the sash position as a
percentage of the total size of paned window.  Again, one saves the
changes by clicking on the green check.

With version 3.2, one can select the TLableframe defining the pane and
drag the edge of it to change the sash position. In other words,
select a pane with Button-1 and drag one of the interior handle; that
will move the sash between the selected pane and the adjacent pane.

The Edit panes window allows one to add additional panes to the window
via the Item menu. The implementation of paned windows sets the
initial size of the paned window to 200x200 pixels and the the first
pane size to 75 pixels.  Adding a new pane adds one at the end (the
right end of a horizontal TPanedwindow or the bottom of a vertical
TPanedwindow, in either case, taking space from prior end pane.
Fortunately you can resize the whole TPanedwindow which changes the
size of the end pane. Then resize the others by changing the sash
positions as described above.

The editor, by including the Move menu and the little up and down
arrows allows one can move the a pane to a new position. Again, the
move operation is circular.

To move a paned window select the whole window then a spot in a sash
between panes and then you can drag the whole paned window.




Ttk Treeview

It was  difficult to provide reasonably good support for the
Treeview widget. I actually do not support the ttk::treeview widget,
rather I have gone directly to the Scrolledtreeview which embeds the
ttk::treeview widget in a ttk::frame with auto-scrolling scrollbars.

What I have been able to do is to support the placement of the widget
in a window with a default of one column in addition to the tree
column both columns are stretchable. By invoking the column editor you
may change many of the characteristics of the widget such as the
column size and heading, as well as the number of columns. It also
allows one to reorder the columns.  Note that the column that contains
the tree has the index of “#0” and must remain the first (left-most)
column.  The column editor is invoked with Button-3 in the widget and
going to Widget->Edit Columns ... as shown below:

[image: _images/column-editor.png]
If the widget were created or a column is added with the configuration
option “stretch” is set to 0 (not stretchable), then when the
resulting GUI is stretched then the column width will not change.  The
enclosing widget with the scrollbars will either have a blank area to
the right of the last column if the window is enlarged or the last
column will not fully show.  To get the more desirable behavior, go
into the Column Editor in the Widget menu and make at least one of the
columns stretchable.




Ttk Entry

While I do support the ttk entry widget, I don’t see any reason to
recommend using it because I am unable to change the widgets font and
I don’t like being stuck with the TkDefaultFont. Strange to say the
ttk Combobox, below, is rumored to be based on the TEntry widget and I
am able to manipulate the font size using the style facility.




Ttk Combobox

The combobox requires a list of selectable values to display in the
drop-down listbox.  These are easily specified from the Set Values
entry of the Widget menu. When invoked from the menu a scrolled text
box appears and the values are specified by entering them one per line
in the text box and then selecting the check mark. The user should
include strings as they should appear in the Python code. That means
if they are string literals, then they should be enclosed in quotes as
shown in the example below. If the quoting is not present it is
assumed that they are variables. I do not want to get into the morass
of entry parsing literal strings.

[image: _images/SetValues.png]
Values can also be set in the “init” function in support module using
code like:

w.TCombobox1['values'] = ('USA', 'Canada', 'Australia')





My style problem with the TCombobox is that while I can use the style
mechanism to change the font of the entry field in the combobox I
have not found a way to change the font of the drop down area
containing the values. In addition, I have not found a mechanism for
changing the values in the drop down list after initialization.




Radiobuttons

TRadiobuttons and Radiobuttons act pretty much the same. One specifies
several of the widgets which are linked by specifying the same
Tkinter variable for all. It is necessary to specify a different value for
each radiobutton. One can also specify an initial value for the
group. For TRadiobuttons the values and variables can be specified
from the Widget menu as well as in the Attribute editor.




Strangeness with Text and Variables

I was surprised to discover a couple of strange things about the way
text is handled with ttk widgets.  There are several ttk widgets,
among them TButton, TMenubutton, Tlabel, TCheckbuttom, and
Tradiobutton, which have both properties of “-text” and
“-variable”. Using the Attribute Editor you can specify the value of
the Text to be displayed in PAGE when you are laying out the
GUI. However, if you then specify the variable attribute, the text
attribute is changed to the zero length string.  I guess that that is
because the variable you named is undefined.  But also the width of
the field containing the text may be set to zero length. So, for
instance, Tlables appear to have zero width unless you have changed
the width prior to specifying the variable.  A Tbutton merely displays
blank text and TRadiobuttons squeezes down to just the
button. TCheckbuttons behaves similarly to TRadiobuttons.

When you generate the Python code the widgets will again appear to
have no text and maybe have no width unless you have set a non blank
value into the Tkinter variable. Tk widgets including Button, Message,
Label, Checkbutton, and Radiobutton behave much the same way.




Label

Label widgets also treat text in an unexpected way.  The justify
attribute applies how multiple lines of text are aligned relative to
each other, it does not set how text lines are placed relative to the
Label widget boundaries.  Use the anchor attribute to specify if the
text block is up against the left of the widget (anchor ‘e’) or the
right (anchor ‘w’).




Listbox

The Listbox widget has the option “listvariable” which one would expect to
behave exactly like one of the Tkinter variable classes.  However, the Tcl
documentation specifies that the listvariable must contain a list of
values to be displayed in the listbox and the possible Tkinter
variable classes are BooleanVar, StringVar, IntVar, and DoubleVar.  By
experimentation I have found that by specifying the var to be
StringVar and setting its value to a tuple of strings will cause each
member of the tuple to appear as an entry in the listbox.  I am rather
surprised at this but glad to find something that works.

The following code

def set_Tk_var():
    global rrr
    rrr = StringVar()
    rrr.set(('a','b','c','d','e'))





results in a scrolled list box looking like:

[image: _images/Scrolled_List_Box.png]



Spinbox

The Spinbox widget has the option values which contains a list of
values presented in the widget as the arrows manipulated.  They are
set using the Widget menu item “Set Values”.  When invoked from the
menu a scrolled text box appears and the values are specified by
entering them one per line in the text box and then selecting the
check mark.




Scale and TScale

Tk does strange things when one tries to modify the narrow dimension
of a scale widget (the height of a horizontal scale or the width of a
vertical one).  So PAGE does not allow one to modify the narrow
dimension during the design phase and restricts the Relative Placement
in the Python code to prevent changes in the narrow dimension.




Scrolled Widgets

To change attributes of the widget being scrolled, it is necessary to
select that widget from the Widget Tree and then make the desired
changes in the Attribute Editor. For instance, to change the
background color of a Scrolledtext widget, select the text widget
indented under the Scrolledtext entry in Widget Tree.

The several scrolled widgets provide auto-scaling; that is when the
widget is actually larger than the viewing area scrollbars are
shown. However, there is no way for the user to change any attributes
of the scrollbars.  The primarily affects the background color which
is the GUI background color which is set in the preferences.




Sizegrip

Support for the ttk::sizegrip widget was included in Version 4.0.
Merely select the widget from the Widget Toolbar and drop it anywhere
within the Toplevel frame but not on top of another widget; it will
bounce to the lower right corner.  Were you to drop it on say a
notebook widget, a weird result would occur like landing in the wrong
place but doing the right thing.

I had difficulties with using Sizegrip with PAGE windows.  It works
fine with the Python Console and the Menu Editor, but I never got a
truly satisfactory result with Widget Tree or or the Widget Toolbar.
I left it with the Widget Toolbar but not with the Widget tree. To be
revisited.




Custom Widget

In writing a photo manager, I needed a variation of a scrolled canvas
to display photos.  I could not find a general purpose candidate for a
scrolled canvas widget, but a found several variations on the web that might
work. So I implemented a Custom widget that can be manipulate in PAGE
but requires the user to supply the Python implementation. So if I
have left something out and you can conjure a tkinter implementation
of it, page can handle it.

PAGE shows a Custom
widget as a Text widget which can be placed and resized like any other
widget. However since the widget has not been defined within PAGE, it is
meaningless to talk about modifying attributes. (It is shown as a
Text widget with the caption “Custom widget”.) The generated Python refers to
it as a class defined in the support module.  To allow execution of
the GUI before the support module is completed, there is included in
the support modle the line:

Custom = Frame





which is followed with user code.

The user then inserts his code for the custom widgets as a class with
the <class_name> of his choosing and follows that code with the line:

Custom = <class_name>





This is the magic that links the widget that you placed with the code
in the support modules. See Custom Widget example.






Generating, Inspecting, and Running the Python GUI

Once the GUI has been defined, the next step is to generate the Python
modules.


Creating and Saving Code Modules

This section discusses the creation and saving of the GUI module and
the support module. I want to make saving simple and intuitive while
reducing the probability of inadvertently overwriting hard to
reproduce code, particularly in the support module.  At the same time
I did not want to bombard the user with “Are you sure ...”
dialogues. These goals are somewhat contradictory. I would appreciate
comments on this subject.

When one chooses to generate the GUI module (Control-P):


	The constructed GUI is transformed into a Tcl file and saved if the GUI has changed in the current session.

	The GUI is also transformed into a Python module called the GUI module and displayed in the Python Console but is not automatically saved. This is to allow the user to peruse the code before committing it to storage.  The user may even change the code since the Python Console code window is a Tk text widget which rudimentary editing capability.

	From the Python Console, the user can  select the Save button and the GUI module will be saved if “new” or changed.  Repeatedly selecting the Save button without changing the code will not result in additional actual saves.

	From the Python Console, the user can select the Run button which provides the same function as the Save button but also attempts to execute the GUI module, if there is an existing support module.



When one chooses to generate the Support module (Control-U):


	The constructed GUI is transformed into a Tcl file and saved if the GUI has changed in the current session.



	If there is no existing support module, then one is generated and displayed in a Python Console.



	If there is an existing support module, action is a bit more elaborate. First, the existing support module is analyzed to see what Tkinter variable and functions are defined in the existing module and compared with those which would be defined in a new support module. Next, the user is given the choice



	use the existing support module, thereby preserving your hand written code,

	generate a new support module,

	update the existing support module updated to include the additional Tkinter variable and skeleton functions.








	From the Python Console, the user can select the Save button and the
GUI module will be saved if “new” or “changed”.



	From the Python Console, the user can select the Run button which provides the same function as the Save button but also attempts to execute the GUI module.





It is important that the support file is not automatically saved when
run is invoked.
.. Since most of the handwritten code of the application
.. will reside in the support module, it is only saved when explicitly
.. requested.
I don’t want PAGE to inadvertently trash your handwritten
application code.  The Python Console has a label which will indicates when the code window has been
modified. That flag is turned on any key is released over the window
and that can indicate changes which may not actually change the text,
i. e., a false positive.




Inspecting the Generated Python Modules

Often the user will want to look at the code that exists for a
project. To do that, execute page with the project name or open the
project and the select Gen_Python->Load Python Consoles. This will
open two Python Consoles; one with the GUI module and the other with
the support module. The loading of the consoles is from appropriate
modules saved to disk. If a Python Console exists with either the GUI
or support module, it will not be overwritten. If one or the other has
not been saved, then nothing is done with the corresponding Python Console.

My guess that this is most interesting when the user has modified the
GUI and generated a new GUI module and wants to see what any existing
support module looks like.  Again, in this situation, the new GUI code
is not automatically saved.




Executing the Python Modules

To see what the GUI looks like, the user can run or execute the GUI
module. That can occur in two contexts, one is to execute the code
from one of the Python Consoles and the other is to load the modules
into an IDE and carry on development from there.  For execution within
PAGE there has to be a Python Console; the user can generate either
the GUI or the support module or load the project into the consoles
from the Gen_Python submenu.

To execute the GUI, select the Run button in a Python Console or using
the shortcut Control-R when the cursor is over a Python Console.

Let me discuss the skeletal functions first. Function references may
be referenced in several ways. If the function name is given the
skeletal function will be created in the support module. An example
would be to specify the command attribute in PAGE as “george”. In that
case, the skeletal support function “george” would be created in the
support module.
.. If the specification were given as “self.george”, the
.. skeletal module would created as a class function within the GUI
.. class.
If another module were specified as in “app.george”
PAGE would not create a skeleton function at all; your on your own to
create and import the “app” module. From this you can see the need to
create the support module before trying to execute the GUI module.

Similarly, Tkinter variable classes are defined or the GUI class or in
the support module depending on the presence or absence of “self.” at
the beginning of the specification.  If specified in the support
module, code is included to insure that the class is created before
the GUI execution references the class.

Because the use of “self.” in specifying functions and Tkinter variables
will require use code to be added to the GUI module, I avoid them in
my usage of PAGE.  Such specifications work against the benefits of
the rework facilities.

I frequently execute the GUI module to see how the Python version of GUI
looks. To that end, the support module is generated with very minimal
skeletal functions in order to check the appearance of the  GUI by
running from the Python console. The final lines of both the GUI
module are:

if __name__ == '__main__':
    vp_start_gui()





and the final lines of the support module are:

if __name__ == '__main__':
   import name
   name.vp_start_gui()





which will call vp_start_gui when the either module is executed. The key
is vp_start_gui which is generated automatically. It contains some
code like the following, where “unknown” is the default project name within PAGE:

import unknown_support

def vp_start_gui():
    '''Starting point when module is the main routine.'''
    global val, w, root
    root = Tk()
    root.title('New_Toplevel_1')
    root.geometry('600x450+650+150')
    unknown_support.set_Tk_var()
    top = New_Toplevel_1 (Interactive Design Environment)(root)
    unknown_support.init(root, top)
    root.mainloop()





The title above reflects the title attribute of the Toplevel window
and, of course, the geometry will reflect the location and sizes you
specify in placing the toplevel widget.

When you select the toplevel widget and Generate Support Module from the
menu, the Python Console will appear, filled with the generated
code for the supporting module named “<name>_support.py”.  This file
will contain skeleton functions and Tkinter variables needed.  This
file will contain the principal code for the application.
.. This
.. is generated automatically once per application.

When you select the toplevel widget and Generate Python GUI from the
menu, the Python Console will appear, filled with the generated
code. You can push the run button and execution will be attempted.
This will automatically save the generated code into a ”.py” file
where the root name matches that of the tcl file which is also
automatically saved.  When running from the Python Window, line output
from the GUI is directed to the lower window of the Python Console.

Execution of the Python GUI is initiated by either selecting the “Run”
button at the bottom of the Python GUI or by typing Control-R. It can
also be run directly by the Python interpreter.

The function “init” is the place to initial things after the GUI
is mapped.




Loading Python files into an IDE

While it is possible to edit PAGE generated files in Python Consoles and
to execute them from there, they don’t really constitute a
particularly good development environment. One
should move into a well concieved IDE like IdleX, emacs, or
any of a host of similar programs.

PAGE can start up an IDE loaded with the Python modules that have been
saved. This is done by
selecting Gen_Python->Load Project into IDE. This does not
automatically save modules from existing Python Consoles.

The IDE is set in the Basics page of the Preferences.  PAGE tries to
execute a the IDE with two the two file names, <name>.py and
<name>_support.py, as arguments.  If your favorite IDE can be so
invoked then it should work.  When running under Linux or OSX, one can
enter either the full path name of the IDE or a command name in the
execution path. If you are on Windows, then the full path name takes
the a form with double backslashes like
“C:\Python27\Lib\idlelibidle” I am not an expert in Python IDE’s,
but I have successfully tested this facility with emacs, vim, idle,
and idlex on Linux; idlex in OSX, and idle in Windows.  For instance,
on Linux in the IDE command field I enter the full path of the
IDE. When I want to use IdleX under Linux I enter
/usr/local/bin/idlex.  I also found that I could enter idlex for
Linux.






Applications with Multiple Top-Level Windows

Often the user will want to build applications which have more than
one top level window.  Since PAGE is built for the specification of
only one such window how does the user proceed?  I think that the best
approach is to create separate modules for each top level window and
have the support module for the main GUI import them using import
statements. The windows can then be created using the create function
in the modules.  This approach was used for the Vrex example above.
Here, I used PAGE to build skeletons for two separate program modules,
the main vrex program and the vrex_help module, and coupled the two by
having vrex, the main module, import vrex_help and invoke the help
window when the “Help” button was selected with the statement:

import vrex_help

def help():
    vrex_help.create_Vrex_Help(root)





Of course, there is very little interaction between the two programs
which simplifies things in this case. As in the example below, the
argument “root” ties the help window to the main window.

The same technique was used in the progress_bar example which shows
more interaction between the windows including the control of the
progress bar window from inside the main routine. Here the two
modules are main.py and progress_bar.py.
In main.py we have

import progress_bar

self.bar = progress_bar.create_Progress_Bar(root)





Here pass to the create routine, the parameter root which ties the two
windows together and the create routine returns the Progress_Bar
object which allows the main GUI to access all of the functions and
attributes of the Progress_Bar object, in turn allowing the main GUI
to advance the bar and to close the progress bar.

Special functions are created in the python code to facilitate the
creation and destruction of the window.

w = None
def create_New_Toplevel_1(root, *args, **kwargs):
    '''Starting point when module is imported by another program.'''
    global w, w_win, rt
    rt = root
    w = Toplevel (root)
    top = New_Toplevel_1 (w)
    unknown_support.init(w, top, *args, **kwargs)
    return (w, top)

def destroy_New_Toplevel_1():
    global w
    w.destroy()
    w = None





One can pass a variable number of parameters to the init function
of the support module using standard Python techniques built around
the “*args, **kwargs” usage.

Obviously, if one wants to pass parameters to the init function of
the window, then one must modify the parameter list to the create
function above and to the call to ini in the above:

def create_Progress_Bar (root, other_args, ...)

     w_win = Progress_Bar (w, other_args, ...)





Also, one may pass a parameter to the “init” function in the support
module. This parameter may be any Python data type - ,integer, float,
etc., as well as lists, tuple, and dictionary.  So it is really a
variable length parameter list.  For instance, you might have code
like the following which I used in the Clone example :

p_dict_1 = {'geom': "+200+650", 'instance': 1, 'color' : 'firebrick'}
p_dict_2 = {'geom': "+1000+650", 'instance': 2, 'color' : 'plum'}


def open_two():
         print "open_two starts"
     firebrick = called.create_Called(root,param=p_dict_1)
     plum = called.create_Called(root,param=p_dict_2)





A common question is how to share global variables across module. A
good reference is How do I share global variables across modules? [http://effbot.org/pyfaq/how-do-i-share-global-variables-across-modules.htm].




Busy Cursors

This section describes how to change the cursor when in long running
sections of an application.  Changing to a busy cursor gives some
feedback to the application user who otherwise may think that the
application is hung, not doing anything.

One includes the following code at the module level of the support module:

# Code added to allow one to change default cursor to a busy cursor.
# Variables added manually to indicate long processes based on code by
# Greg Walters in his python programming examples.  These routines
# also can be seen in the Greyson book pg. 158.
busyCursor = 'watch'
preBusyCursors = None

def busyStart(newcursor=None):
    '''We first check to see if a value was passed to newcursor. If
       not, we default to the busyCursor. Then we walk through the
       busyWidgets tuple and set the cursor to whatever we want.'''
    global preBusyCursors
    if not newcursor:
        newcursor = busyCursor
    newPreBusyCursors = {}
    for component in busyWidgets:
        newPreBusyCursors[component] = component['cursor']
        component.configure(cursor=newcursor)
        component.update_idletasks()
    preBusyCursors = (newPreBusyCursors, preBusyCursors)

def busyEnd():
    '''In this routine, we basically reset the cursor for the widgets
       in our busyWidget tuple back to our default cursor.'''
    global preBusyCursors
    if not preBusyCursors:
        return
    oldPreBusyCursors = preBusyCursors[0]
    preBusyCursors = preBusyCursors[1]
    for component in busyWidgets:
        try:
            component.configure(cursor=oldPreBusyCursors[component])
        except KeyError:
            pass
        component.update_idletasks()
# End of busy cursor code.





and the following lines of code are inserted in “init” in the support module:

global busyWidgets

busyWidgets = (top, )





The first line goes in near the top of the function and the assignment
to busyWidgets is inserted after the root object is created. In one of
my applications the function “init” looks like:

def init(top, gui):
    ''' Function to create the thread for periodically updating the GUI.'''
    global t
    global w, top_level
    global busyWidgets
    w = gui
    top_level = top
    t = threading.Thread(target=fill_window,)
    t.start()
    busyWidgets = (top, w.Scrolledtext1)





The final line above sets the global variable busyWidgets to be a
tuple of those widgets I wish to display the busy cursor.  This is
from the example WCPE where I want the busy cursor to appear
in the top level window as well as the Scrolledtextbox.

When starting a section of code which is likely to be long running, a
busy section, insert the following at the start:

busyStart()





When leaving a busy section make the following the last statement():

busyEnd()





Obviously, an application could have numerous busy sections and they
might coincide with particular functions or not.

This code can be generalized for usage of any of the Tkinter cursors.
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Menus

PAGE supports toplevel menubars and context menus often called popup
menus.
PAGE does not support menubuttons.

A popup menu is essentially a callback function bound to a selected
widget.  Of course, that binding is specified using the Bindings
Window.

There is a Menu Editor which facilitates the creation and modification
of all the menus for PAGE.

Creation of Menu Bars can be confusing because PAGE bridges Tcl and
Python.  Let me try to explain!  When you create a toplevel window and
populate it, you are actually building an interactive tcl program that
will later be translated into Python modules.  If you populated the
toplevel widget with a button PAGE binds Button 1 in such a way that
when you click on it, all kinds of magic occurs - the Attribute Editor
opens for business, and menus may popup allowing you to cut and copy,
specify bindings, etc. - you don’t actually invoke any callback you
associated with the button.

With the menu bar, things are different, in that the menu does
function in the tcl world.  That is, if you specified a cascade sub
menu, say File, in the menu bar, and then you click on File in the
menu bar the cascade menu opens so you can see it.  I think that is
good because it allows you to see the structure of the menu bar as you
create it.  However, if you put in a command entry like Quit and tie
it to the function “quit”, which you intend to implement in the Python
world, and then in PAGE click on Quit in a menu, Tcl/Tk will attempt
to execute “quit”.  However, there is no tcl “quit” function defined
in PAGE; therefore, you would get a Error window stating “invalid
command name “quit”.  To avoid this confusing Error message, I have
change PAGE in version 4.8.9 to prepend a “#” to the actual command
entered in the Menu Editor though it is not shown in the Menu Editor
window, so that selecting a command in the menu bar a comment is
invoked, i.e, nothing happens; it’s a comment. When the Python code is
created, the “#” is. of course, removed.  These modifications are in
effect for menu commands newly specified or modified. Menus commands
specified with earlier version can still give rise to the error. If
you see such an error message, you may confidently select OK and
continue working with PAGE or you can change the offending command
entry - just one character will do as I did with the examples - and
then continue.

The confusion does not occur with context (popup) menus because they
are callback functions and, therefore, never visible in PAGE.


Menu Creation

The menu capability that I use most is the menubar at the top of a top
level window.
To create such a menu bar, one selects the Toplevel widget and then invokes
the Menu Editor in one of several ways


	select <click-to-edit> menu field in the Attribute Editor,

	right click in the Toplevel widget and select Widget->Edit Menu,

	right click on the Toplevel widget
in the Widget Tree and select Widget->Edit Menu.



As you edit the menu you will see the menu bar changes appear in the
Toplevel Widget; you will not see any of the cascade menus appear.

To create a popup menu one selects the Popupmenu widget in the Widget
Toolbar. Then right click on the Popupmenu widget and select
Widget->Edit Menu. You can also select the widget and the
<click-to-edit> menu field in the Attribute Editor.  You do not place
it in the toplevel window because that would have no meaning.
However, there are menu attributes such as colors and fonts that can
be modified in the Attribute Editor.  As you edit the popup menu you
will not see anything changes in PAGE windows.  You can have more than
one popup window and a popup window can be associated with more than
one widget. The popup menus are called Popupmenu1, Popupmenu2, etc.;
in turn, they are implemented in corresponding class functions called
popup1, popup2, etc.

Note that while the Widget Tree shows menu bars as child widgets of a
toplevel widget, context widgets are shown as child widgets of the
root widget.  The difference is because the context menus are
associated with child widgets only by binding events, usually mouse
buttons, to the widgets.




Menu Editor

The Menu Editor creates menus. It is invoked as above.

Some of the items in a menu may be simple commands like “Quit”
which invokes your quit function. Others are cascade menus like File
which are sub-menu of items like “New”, “Open”, “Save”, etc. To
specify an action like the “Quit” example,


	Select the <Menu> item at the top of the left field.

	Insert->Command.

	Select the entry “New Command”.

	Go to the label entry on the right hand side of the editor and
change the label to Quit and hit the enter key.

	Go to the command entry and enter the name of your quit command and
hit the return key.

	You can change any of the options shown in the right window of the
Menu Editor, like background color, font, etc.

	Images are added to the menu item by selecting the ellipsis to the
right of the image option and using the file open dialog to select
the image file.

	Use the arrow buttons or Move menu to move the selection up or down
as desired.



To put in a cascade menu like File,


	Select the <Menu> item at the top of the left field.

	Insert->New Cascade.

	Go to the label entry on the right and Enter File.

	Use the arrow buttons or Move menu to move the selection up or down
as desired.



To add Open to the File menu,


	Select File on the left.

	Insert->Command

	Select “New Command”

	Change its name as above.

	Specify the command as above.

	Move it up or down as desired.



Of course, you can add cascaded menus to cascaded menus, etc..

When you are all done hit the Check Button on the right.

The menu editing window is repeated below:

[image: _images/menu.jpg]
When adding entries to a cascade menu, that entry can be another
cascade menu. See the reference to the example below.

When creating a menu, one can start by adding either commands which is
most common case or a cascade menu which leads to a second level menu.
Some of the Tcl/Tk documentation for menus bars say that one should
only place cascade items in a menubar.  However, I have found it
useful and intuitive to have all kinds of items in the menu bar.

I have modified the Menu Editor to allow one to change various colors
of individual menu items as well as the fonts for individual items.
Then it occurred to me that one should be able to set preferences for
default values of menu fonts and foreground and background colors. I
have modified the Preference processing to do that.  I have not
allowed one to set preferences for active foreground or background
values. The net setting are in the Fonts and Colors tabs; in the main
PAGE menu go to File->Preferences...->Fonts or
File->Preferences...->Colors.

Points about adding images to menu entries:


	At this point Tkinter will only work with GIF and PGM/PPM images
from files. If for example, you have a jpeg you will have to convert
it one of the acceptable formats.

	Also, when adding images to a menu and you have text as well, it is
necessary to set the appropriate value in the compound attribute
telling PAGE whether the image is to be on the left, right, top,
bottom or center.

	The menu.py example does not work as well under XP as it does
under Linux Mint 12. Specifically, the image and label specified for
the left button of the menubar are replaced with “(image)”.  I
rashly think this is a Tk bug.



I have included menu.tcl in the examples subdirectory to illustrate
some of the things that I have done to test the menu bar
facility. Load it, generate the Python and execute it. I wrote the
example to test the change in menu fonts and colors as well as having
several images and several level of cascaded menus.  I certainly do
not advocate using weird images, colors and fonts all over the
place. But you can.

I am uncertain about the best way to handle fonts in menus.  PAGE now
sets a variable that is used as the default menu font and that
specification is forced everywhere in the menu that is not specified
otherwise. However, once specified it is fixed. You cannot change it
without re-specifying it everywhere it is used.  I may revisit this issue.

The radio menu entry type has options “value” and
“variable” which need attention.  When a radio button is selected, the
variable is set to value. That is, if variable is x and value is a
then x is set to a, when the radio button is selected. The way the
menu editor works is that when a radio entry is added to a
menu, the label and value are set to “NewRadio” and the variable is set
to “selectedButton”. If you wish to use the variable setting then you
must change the variable to a different value, one you wish to
use. PAGE will change create the correct Tkinter Variable Class of
type string. It will also threat the value of the value field as a
string constant. Change that field to a value that works with your
application. Bare in mind that with radio entries in a menu they must
all share a singe variable.

The Check menu entry type has options “onvalue”, “offvalue”, and
“variable” much like radio entries.  The main difference is that the
check entry expects that each entry will have its own variable; they
are not shared.  Again, the PAGE implements the variables as StringVar
objects and “onvalue” and “offvalue” as string constants. The variable
stuff associated with menus can be bypassed by specifying distinct
functions in the command options or by passing distinct parameters to
the command function using the lambda function.




Menu Modification

To modify a menubar, one needs to open the Menu Editor for the menu
bar. That can be done several ways.

One way to open the Menu Editor is to select the Menu widget in the
Widget Tree with Button-1 then select the <click-to-edit> field in the
Attribute Editor window. The Attribute Editor can also be used to
change the menu font, menu colors, etc.

Another way is to select the Menu Widget in the Widget Tree with
Button-3. Then select Widget->Edit Menu....

Yet another way way is to select the Toplevel widget and then the
<click-to-edit> field next to the menu label in the Attribute Editor.

Also, select the Toplevel widget in the Widget Tree with Button-3,
then Widget->Edit Menu Bar.




Popup Menu Binding

The final topic to cover is the binding of popup menus to individual
widgets.  Popup menus are usually activated by mouse events bound to
particular widgets.  The Tk documentation discusses bindings of mouse
events to widgets for different OS’s and PAGE attempts to follow those
conventions.  This is one of the above mentioned hacks.  Note that a
GUI may have more that one context menu and also more that one widget
may be bound to a context menu.  As an example, Lib Demo a
photo album like example which displays a number of thumbnail images
each of which can invoke the same popup menu.

PAGE implements the callback functions for popups as class methods of
the toplevel class because these functions are generated by
PAGE. Other callback functions are generated as skeletal functions in
the support module.  Callback functions for context menus and the
menus themselves have special names.  The context menus have PAGE
generated names like Popupmenu1, Popupmenu2, etc. and the containing
callback functions are popup1, popup2, etc.  The latter names are
reserved for pupup callback functions. This is part of the hack
mentioned in the last paragraph. Since there is a close relation
between the menu names and callback names, Popupmenu<n> and popup<n>, do
not modify menu aliases.

If a popup menu is bound to a widget it is applicable for all
subwidgets of that widget. So if you bind a popup menu to the toplevel
widget and also bind another popup menu to a subwidget, say a button
then hitting the popup button, Button-3 in Linux, both menus will
popup.
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Rework

With version 4.2, I turned my attention to facilitating rework in
PAGE.  That is, how do you use PAGE to tweak the GUI without loosing
the supporting code that you have written? At the same time I want to
allow one to view the changes with the run command button in the
Python console.

Here is the situation.  You design a GUI and generate the Python code
using PAGE, which creates skeleton functions.  You then fleshed out
the skeleton functions to support the GUI and then decided to modify
the GUI.  If then you again generate the Python code for the GUI, you
do not want to loose the application code which you have written to
realize the application.  This is the rework problem: How to keep your
hard fought code when reworking the GUI?

Starting with version 4.2, I have tried to separate as completely as
possible the automatically generated GUI code from the added support
code.  My approach is to create the generated GUI code in one Python
module and the supporting code including skeleton functions and Tk
variables in a separate Python support module to be imported by the GUI
module.  That is, now PAGE generates two Python modules, one for the
GUI and one for the supporting code complete with the necessary
linkage.

PAGE implements this schema as follows.  PAGE now works with three
files:


	“<name>.tcl” which is the design description of the GUI suitable for input to PAGE. It can either be created in PAGE, passed to PAGE as a parameter, or opened from the File submenu of the main menu.

	“<name>.py” which is the main python module generated by PAGE which contains the automatically code to create the GUI on the screen. It is meant to be completely generated by PAGE. This will be referred to as the GUI module.

	“<name>_support.py” which contains the code supporting the GUI module. PAGE creates a skeleton of this module that contains all of the necessary boiler plate code for linkage to the GUI module as well as the definitions of the Tkinter variables and skeleton versions of callback routines.  I will be referring to this as the support module.



In the above, “<name>” is the application name (it was called the
project name in the original Visual Tcl program) selected by the user
when the system saves the ”.tcl” or extracted from the file name which
may be supplied as a parameter when invoking PAGE.

It is expected that the user will generate a new version of the GUI
module whenever he modifies the GUI but will need PAGE to modify the
support module only when new Tkinter variables or callback functions are
defined. The first will be much more frequent than the
latter. Further, version 4.3 provides a mechanism for updating the
support module by adding the new Tkinter variables and callback functions
skeletons to an existing support module.

Generation of either Python module will attempt to save the tcl file
and in so doing may ask if you really want to save it. If you do not
answer “yes” the root file name may not be known and bad code could be
generated.

Let me repeat: You should only generate the support module once for an
application; otherwise any code which you manually added will be lost.
Well, just in case you do that inadvertently, PAGE will save some
previous versions as backups.  If you add new or change widgets in the
GUI or modify callback functions or Tkinter variables changes will have to be
made to the support module.

When saving the support module PAGE will test to see if a support
module with the same name exists and if it does, it will question the
user as to whether he wishes to continue and if continue, whether to
replace or update the module.

For an example of the separation of the GUI module from the support
module, see the WCPE directory in the examples directory.  This is a
program that displays the program of WCPE which is one of my favorite
classical music stations.  In this example all of the functional code
is located in WCPE_support.py and the GUI design is recorded in WCPE.py
which is the main module.  I found it very tricky to deal with time
zones and did not want to loose any of that code and have to redo it
or to deal with diffs; at the same time, I was constantly tweaking
the GUI.  I generated the import module once and proceeded fill out
the “init” function and the callback functions in WCPE_support.py while
tweaking the GUI, i.e., changing its location, color, the size of the
display fields, fonts, etc..

It may be instructive in that it exemplifies an application comprised
of two top level windows where one of the windows accesses Tkinter
variables in the second window.

With chagrin, I apologize to the PAGE users for not having thought of
this solution to rework long ago.  Even though I have tested the idea
with several examples, some of which are included in the section on
examples, I worry that I have overlooked something big.  So if you
find any problems or oversights, please let me know.


Automatically Updating the Support Module

The is the new feature of PAGE introduced with version 4.3.  The basic
idea is that reworking the GUI design may introduce new callback
functions or Tkinter variables which need to incorporated into the support
module. PAGE can now add those entities to the support module.  That
is, new skeletal functions are added and new entries are added to the
set_Tk_var function, if necessary the set_Tk_var function is added. All this
while leaving the rest of the existing support module unchanged.

If Control-U was selected to generate the support module, then the
user will be given the options of:


	generating the support module anew,

	using an existing support module, thereby utilizing the existing handwritten code; the old support module will be displayed.

	updating an existing support module to preserve the existing code and adding new Tk Variables or skeleton callback functions.



To rephrase the above, when the user selects Gen_Python->Generate
Support Module from the main menu or selects Control-U, PAGE will
analyze an existing support module and compare the callback functions
and Tkinter variables in it with those utilized in the reworked design.  If
new entities are required the user will be given the option of
automatically adding them.  Existing code is not removed or modified.
It is up to the user to remove or otherwise deal with code no longer
needed.

To mitigate case where the update process damages an existing support
module, PAGE keeps several backups.
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Examples

Examples are the main way that I learned about Tkinter and how to
write code for building GUI’s .  Unfortunately, it is hard to find
examples.  Grayson’s book has been an immense help over the years and
more recently the pyttk-samples distributed by Guilherme Polo have
helped greatly.  The official Tcl documentation is pretty much limited
to man pages which are of minor assistance in getting started with
Tkinter. The tutorial on the Tcl Developers site [http://www.tkdocs.com/tutorial/index.html] only recently included
Python code. Much experimentation was required before I was able to
see a paned window on my screen or a scrolled directory.  There are
several interesting examples in the examples subdirectory.

So one may experiment with the examples changing sizes, colors, fonts,
etc. in the GUI modules and they should still work if he does not
regenerate support modules.  At least, one can see some of the
possibilities.  Of course, I have created some of them like menus in
poor taste just to illustrate some of the possibilities. You may
encounter some difficulties which may be due to the absence or miss
match of fonts, etc. between my system and yours.

The easiest way to try the examples is to go to one page/examples
subdirectories and (1) run page against the a ‘.tcl’ file in
that directory and (2) execute the generated GUI module.  Most of the
examples have only one ‘.tcl’. Several examples have two GUI’s and
usually has a ‘main.tcl’; vrex the main GUI is ‘vrex.tcl’ and in ‘two’
the main GUI module definition is ‘w1.tcl’.

If you try saving  the examples by executing PAGE on the Tcl files be
aware that generating and saving support files will replace the
included support files which will become backup versions and the
functioning of the applications will be lost unless the respective
files are restored.


Directory Browser

This example contains a scrolled treeview widget that displays ones
UNIX directory tree.  The source for this example is in
examples/directory-tree.py It is a rework of Polo’s example to include
folder icons which open and close.  Polo’s example is Based on
bitwalk’s directory browser [http://bitwalk.blogspot.com/2008/01/ttktreeview.html].

[image: _images/dir-tree.png]



Vrex

In the past I have used a number of regular expressions in Python and
used to great advantage Visual Regexp [http://laurent.riesterer.free.fr/regexp/] in composing and testing
those regular expressions and thought that rewriting the program in
Python would be interesting because


	It would illustrate important capabilities of PAGE.

	It would be a useful program in its own right. Indeed, I use it all
the time.

	The original version was written in Tcl/Tk and so uses the regular
expression processing of Tcl which is bound to be slightly different
from that in Python. So an all Python version using the Python
regular expression processing would be true to Python.

	The original program had ZERO documentation. I never could figure
out all of the facilities present. (The most recent version has one
page of documentation.) I wanted a version that I could document.

	This example illustrates several points about PAGE support: Building
menus, using paned windows, text colorization, synchronization
between two scrolled text windows, and a project utilizing two windows.



[image: _images/Vrex_for_Python.png]
The main portion of the GUI is a three pane window for entering the
regular expression and sample in the first two and the third pane
presents match results based on the selection of buttons at the
bottom.

Some of the features of PAGE illustrated in this useful program are:


	Scrolled text widgets nested inside of label frames.

	Use of two separate GUI’s, one for the main function of the program
and one for a help window.

	Colorizing the text within the scrolled text windows.




Vrex Operation

Briefly, Vrex works as follows:

One enters the regular expression under test into the top text box,
and the sample which is the subject of the regular expression match
into the middle text box.  One may use the File menu to load files
into the text boxes, one may directly type entries or use the normal
cut and paste facilities of the operating system.  The user can also
save the regular expression and sample using the File menu.


	Pressing the Go button causes the match to be attempted.  Also,
colorization is applied to both the regular expression and to the
sample. The regular expression is colorized to show the portions of
the regular expression are to extracted individually. And if the
match is successful the corresponding portions of the sample are
displayed in the same colors.

	By selecting one of the row of buttons marked match, 1, 2, ..., 9,
the portions of the sample corresponding to extracted subpatterns are
displayed in the match window.

	You can use the File menu to load to save both the regular expression
and the sample.

	The Quit Button terminates the program.

	The File menu also has a Quit entry that terminates the program.

	The Help menu opens a second GUI containing a ScrolledText widget
which has help information.



The regular expression should be colorized showing the portions to be
extracted in different colors and as well as the matching portion of
the sample.

If you then Select Match, that matching portion of the sample will be
shown in the Match text box. Select 1, and the portion matching the
sub expression will be shown, etc..

You can also load a file into the sample window and thus run the
regular expression against many strings.






Progress Bar

This example shows the usage of the progress bar widget but is included
mainly for illustrating an application with two top level windows.  It
shows how the main window is able to interact with variables and
procedures in the imported module which actually displays the progress
bar.

Important features illustrated include the creation and destruction of
the secondary top level window and the fact that the main GUI support
code requires access to Tkinter variables defined and manipulated in
the support module of the other, progress bar, window.




Complex

This really isn’t much of an example doing nothing but does showing
nesting of a paned window inside of a paned window and a notebook
widget nested inside of a paned window. By the way, one can enlarge
the top level window and copy and paste the whole paned window to a
new location.




Menus

There are two directories page/examples/menu and page/examples/popup
which demonstrate menus

The menu directory contains a fairly extreme menu bar example.  Note, I do not
advocate this as a style to be used; it merely suggests some of the
things that can be done.

While this example works as expected on my Linux Mint 13 machine, it
does not work as well on my XP machine. The way it was conceived,
there is a small image to the right of the label in the left of the
menu bar. However, on XP neither the label nor the image is shown.
What one gets is “(image)”.  Strange since if you go down several levels
there is an image to the left of one of the check buttons. I think
that is a problem with Tk.

The popup directory example has a top level window with two buttons
and a different context menu attached to each.  To see the popup
menus right click on the buttons.  You will note that the two menus
have different colors.




standard.tcl

This is just a top level window with each of the standard Tk widgets
that I support.  It just shows that I can generate working Python code
for each.   The lowercase ‘s’ emphasizes that it doesn’t do much.




themed.tcl

As above for the themed widgets.




Canvas

Paul Krieger donated a canvas example which can be found in the
<page_dir>/examples/canvas directory. I am very thankful since I have
no facility with the canvas widget.

[image: _images/p-canvas.png]



WCPE

See the WCPE directory in the examples directory.  This is a program
that displays the program of WCPE which is one of my favorite
classical music stations.  In this example all of the functional code
is located in WCPE_support.py and the GUI is defined in WCPE.py which
is the main module.  I found it very tricky to deal with time zones
and did not want to loose any of that code and have to redo it or to
deal with diff’s; at the same time, I was constantly tweaking the
GUI.  I generated the import module once and proceeded fill out the
“init” function and the callback functions in WCPE_support.py while
tweaking the GUI, i.e., changing its location, color, the size of the
display fields, and change of some display fields from entry boxes to
labels.

This example requires the Python time zone package pytz which is
available from Python Package Index [http://pypi.python.org/pypi/pytz/].

[image: _images/WCPE.png]
This example utilizes:


	Labels linked to Tkinter variables to display information like times,
composer, artist, etc.

	A Scrolled text box which displays the whole play schedule for the
day and colorizes the current piece and makes sure it is displayed
within the window.

	Busy cursor to alert the user that the application is awaiting
playlist information from the web.



In addition I fuss around with reading and parsing web pages and time
zone calculations.




Clone

This is a somewhat kooky example located in examples/clone, where
main.py creates a GUI which presents a button “Make Two” which cause
the creation of two instances of the “called” GUI but with differing
characteristics of location and background colors.  The called GUI is
then able to create incidences of clones with different locations and
background colors.

It is also an example of passing a user parameter to the creation
module which is then passed to the “init” function in the support
module where the color and location are manipulated.

There may be a problem executing this example on Windows if fonts
selected in the tcl are not available on the Windows machine. In that
case the font will default to TkDefaultFont.  Courier New is available
on both my Linux system and my XP box.

This example show two way of defining the textvaribles associated with
the label widgets in the called GUI.  One way is to define
(automatically) as a Tkinter variable in the support module. The second is
to define, again automatically, as a variable in the GUI module by
defining it as “self.<variable>” in the attribute editor.  PAGE
supports both, but I now see no advantage to using the second way, and
I think it is a bit more confusing.




Calendar

Small example of building a calendar display using the new rework
scheme. It is located in examples/calendar subfolder.

[image: _images/calendar.png]



CPU Info

Another small example which displays the output of lscpu on a Linux
system. This does not execute properly on Windows machine because it
utilizes a Linux command.

[image: _images/cpu-info.png]



Bind

This subdirectory contains a bind example where the button
responds to selection with <Button-1> via the command attribute
set in the Attribute Editor and to <Button-2> and <Button-3> via
bind commands created using the Binding Window.

The function named in the command attribute is different from that
in the bind statement because in the latter case an event object is
passed as a parameter to the event handler so the handler must have an
argument to accommodate the event object.




Custom Widget


ScrolledFrame

This example, in <page-dir>/examples/custom/canvas, shows how I used a custom
widget called ScrolledFrame which I borrowed from the web. This widget
is used to display 100 buttons on a scrolled canvas.

When the user open PAGE with canvas.tcl, he sees

[image: _images/canvas-tcl.png]
which shows the toplevel window filled with a custom widget. Since the
structure of the widget is unknown to PAGE, it cannot be shown or
manipulated other than sizing or placement.

When the support module custom_support.py is completed with the Python
Tkinter implementation, execution yields

[image: _images/custom-widget.png]
The main module is canvas.py and the magic is contained in
canvas_support.py, which contains the Python/Tkinter code to implement
the class

In canvas.py the custom widget is referred to in the line:

self.Custom1 = canvas_support.Custom(top)





In canvas_support.py the line of code:

Custom = Frame





is generated by PAGE causing the Custom widget to implemented as a
Frame widget. In other words, the name Custom refers to the Class
frame. This allows PAGE to display the Custom widget as a Frame widget
with the annotation of “Custom widget” and the execution of the
generated Python code to display the Custom widget as a Frame prior to
including the tkinter implementation in the support module.

The user-added implementation of the ScrolledFrame class at the bottom
of canvas_support.py begins as follows:

import Tkinter

# I found this code on the web at
# http://tkinter.unpythonic.net/wiki/ScrolledFrame and thought it would
# implement a canvas widget that I could use with PAGE, but I don't understand
# it well enough to put it in my supported widgets.

GM_KEYS = set(
        vars(Tkinter.Place).keys() +
        vars(Tkinter.Pack).keys() +
        vars(Tkinter.Grid).keys()
        )


class ScrolledFrame(object):
    _managed = False
    # XXX These could be options
    x_incr = 10
    y_incr = 10

    def __init__(self, master=None, **kw):
        self.width = kw.pop('width', 200)
        self.height = kw.pop('height', 200)

        self._canvas = Tkinter.Canvas(master, **kw)
        self.master = self._canvas.master

        self._hsb = Tkinter.Scrollbar(orient='horizontal',
                command=self._canvas.xview)
        self._vsb = Tkinter.Scrollbar(orient='vertical',
                command=self._canvas.yview)
        self._canvas.configure(
                xscrollcommand=self._hsb.set,
     ...

Custom = ScrolledFrame





That last line of code in canvas_support.py causes the name “Custom”
to refer to the class ScrolledFrame. It overrides the previous
reference to the class Frame. It is the incantation magic that causes
the Custom1 widget in canvas.py to be implemented as an instance of
the ScrolledFrame class.




Lib Demo

This is a second example using the ScrolledFrame widget.

For testing of PAGE, I recoded a photo library program which I wrote
several years ago using PAGE to generate the seven GUI’s required for
the program.  For this example, I have stripped it down to just one
GUI which provides multiple display of just one image.

The demo generates the following window:

[image: _images/lib_demo.png]
It displays repeated copies of the thumbnail image of a particular
photograph as images on a Button widget. If one selects an image
button with Button-1, a message appears containing the index of the
button. If one selects a button with Button-3, a popup menu appears.
The Zoom cascade menu in both the toplevel window and the popup menu
allows one to change the size of the images displayed.  There is only
one image included in the example and it is displayed 30 times.

When the toplevel window is filled, the program determines, the
maximum number of images that will fit horizontally and puts that
number in each row. If the image is too big to fit, one image per row
is displayed but spills over the edge.

I have included the Busy Cursor code which is located in the shared
module. However, the refresh is so fast, one can hardly see the
different cursor.






Fnew

This is another attempt to abstract some features of my photo library
project, namely the use of a popup menu with different fonts.




Two

This is an example of a project which contains two simple windows w1
and w2.  It issustrates how the support module for window 1 creates
window 2 and passing it a parameter which is used to set a label. It
also has another example of the TProgressbar widget.




Rplay

[image: _images/rplay.png]
This example was written as a music server for my Raspberry Pi which
drives my audio system from CD images stored on a Linux box. I use this
program daily.  In this example I have a number of different bindings
and utilize a number of text widget tricks that I discovered by
experimentation as well as using multiple threads to run the mp3
player while keeping the GUI fairly responsive.
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Epilogue


Final Recommendations

My final recommendation are



	Save often.

	Spring for Grayson’s book.

	Save often.

	Please report problems.
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found it very satisfactory and give my thanks.

Also borrowed was ColorExplorer written by William J. Poser.

Alexander Walters suggested the code for importing the tkinter and ttk
modules adopted in PAGE 4.1.

Sam Manzi made numerous helpful suggestions and helped test recent
versions of PAGE.

Many people have reported bugs and made suggestions. Piero Ronchi and
Paul Kreiger have been especially helpful. In addition, Paul Kreiger
donated a set of PAGE icons and a canvas example.

Bob Stanton suggested displaying both the GUI module and the Support
module in separate Python Consoles and also firing up an IDE with the
two modules. Both were excellent ideas and so implemented.




Documentation

One problem that many people must encounter when trying to use Tkinter
with python is locating adequate documentation.  I relied heavily on
Grayson’s book particularly to see how to map the various tcl calls
and configuration options into python calls and for descriptions of
the available functions.  I would have gotten nowhere without this
reference.  Unfortunately, Grayson predated the ttk widget set by
several years.

Another extremely helpful reference is: An Introduction to Tkinter by Fredrik Lundh [http://www.pythonware.com/library/tkinter/introduction/index.htm].

Recently, Full Circle Magazine [http://www.fullcirclemagazine.org],
a very interesting web magazine devoted to Ubuntu and Ubuntu derived
Linus distributions, has published a series of Python HOW TO articles
written by Greg Walters [http://www.thedesignatedgeek.net/python.html].  The series covers
introductory Python programming articles as well as several devoted to
GUI programming including Tkinter and two articles on using PAGE. A
partial list of articles may be found at Greg’s Web site above.
Fortunately, there have been four special issues of Full Circle
Magazines which have collected all but the most recent of Greg
Walters’ articles.  They may be found at:








	Volume
	URL for download
	Size




	1
	http://dl.fullcirclemagazine.org/issuePY01_en.pdf
	7 MB


	2
	http://dl.fullcirclemagazine.org/issuePY02_en.pdf
	19 MB


	3
	http://dl.fullcirclemagazine.org/issuePY03_en.pdf
	17 MB


	4
	http://dl.fullcirclemagazine.org/issuePY04_en.pdf
	16 MB





Volume 4 does not contain the most recent articles (30 and 31) which
deal with PAGE.  I have put those together as python-page.pdf [http://page.sourceforge.net/pdf/python-page.pdf].  In the future I
fully expect that these articles will be incorporated in another
Python Special issue. Until then I will keep this pdf on the PAGE web
site [http://page.sourceforge.net].

I have also found Tkinter 8.5 reference: a GUI for Python [http://infohost.nmt.edu/tcc/help/pubs/tkinter/web/index.html] by
John W. Shipman from New Mexico Tech helpful on many occasions.

See also http://effbot.org which contains hundreds of articles on
Python and related technologies (including PIL, ElementTree, Tkinter,
and other extensions). I have used this reference repeatedly.

For Tcl/Tk documentation visit: Tcl Developer Site [http://tcl.activestate.com].

A very useful Tk tutorial with information about ttk widgets and styles
is TkDocs [http://www.tkdocs.com/tutorial/index.html].

Since some people find Python Lambda usage confusing, Grant Hilebrand
suggested including a reference to the excellent tutorial at
https://pythonconquerstheuniverse.wordpress.com/2011/08/29/lambda_tutorial/.

Unfortunately, there is no useful documentation for Visual Tcl like so
many Open Source projects.

I have recently turned on a discussion forum on the SourceForge
summary page General Discussion [https://sourceforge.net/p/page/discussion/?source=navbar].

For information on sharing variables and functions between Python
modules see is how to share global variables across module. A
good reference is How do I share global variables across modules? [http://effbot.org/pyfaq/how-do-i-share-global-variables-across-modules.htm].


Reporting Problems

I really welcome the reporting of problems; that is the only way I can
catch many of them. When reporting problems to Don dot Rozenberg at
gmail dot complease include the following:


	The version number of PAGE.

	The OS you are using.

	When PAGE dies it often shows an Error window which has a Trace back
Button, which if selected produces a separate window containing a
trace back of PAGE indicating the offending or offended code. Please
if possible, send me a screen capture of that window.

	If possible the tcl file that caused the error. Even better would be
a simple case causing the same error.
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Creating and Saving Code Modules


This section discusses the creation and saving of the GUI module and
the support module. I want to make saving simple and intuitive while
reducing the probability of inadvertently overwriting hard to
reproduce code, particularly in the support module.  At the same time
I did not want to bombard the user with “Are you sure ...”
dialogues. These goals are somewhat contradictory. I would appreciate
comments on this subject.


Here is what I have tried to implement:



GUI Module


When one chooses to generate the GUI module (Control-P):



		The constructed GUI is transformed into a Tcl file and saved if the GUI has changed in the current session.


		The GUI is also transformed into a Python module called the GUI module and displayed in the Python Console but is not automatically saved. This is to allow the user to peruse the code before committing it to storage.  The user may even change the code since the Python Console code window is a Tk text widget which rudimentary editing capability.


		From the Python Console, the user can  select the Save button and the GUI module will be saved if “new” or changed.  Repeatedly selecting the Save button without changing the code will not result in additional actual saves.


		From the Python Console, the user can select the Run button which provides the same function as the Save button but also attempts to execute the GUI module, if there is an existing support module.








Support Module


When one chooses to generate the Support module (Control-U):



		The constructed GUI is transformed into a Tcl file and saved if the GUI has changed in the current session.





		If there is no existing support module, then one is generated and displayed in the Python Console.





		If there is an existing support module, action is a bit more elaborate. First, the existing support module is analyzed to see what Tkinter variable and functions are defined in the existing module and compared with those which would be defined in a new support module. Next, the user is given the choice




		use the existing support module, thereby preserving your hand written code,


		generate a new support module,


		update the existing support module updated to include the additional Tkinter variable and skeleton functions.












		From the Python Console, the user can select the Save button and the
GUI module will be saved if “new” or “changed”.





		From the Python Console, the user can select the Run button which provides the same function as the Save button but also attempts to execute the GUI module.
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Module Structure


PAGE generates two modules, The GUI module, and the Support
Module. The first contains all of the Python code necessary to plop
the GUI window onto the computer screen. In my vision of the PAGE
word, the GUI module is not to be edited. It contains all of the
required linkage to the Support module.  It is generally the main
module of the application.


The Support module is generated in skeletal form and is the framework
upon which the application is built. It is where the user written code
resides.  As such it is infrequently generated or replaced by PAGE. In
fact, the separation is the secret of rework; it allows changes
to the content and appearance of the GUI window while preserving the
user’s code.



GUI Module


The main feature of the GUI module is the class definition, which
defines a GUI window.  It defines the top level window and all of the
contained widgets.  Note that it refers to all callback functions as
functions in the support module and that Tk variables such as
textvariables are referred to Tk variables in the support module.


The GUI module contains two stylized function for instantiating the
window class. They are:


def vp_start_gui():
        '''Starting point when module is the main routine.'''
    global val, w, root
    root = Tk()
    top = New_Toplevel_1 (root)
    unknown_support.init(root, top)
    root.mainloop()






which is the entry point when starting the routine as the main routine
of the application. The main thing about this is that it initializes
Tk and establishes the Tkinter mainloop.  It is called when this
module is executed as the main module. Note that the init function in
the support module is passed  pointer to the GUI window class.


and


def create_New_Toplevel_1(root, *args, **kwargs):
         '''Starting point when module is imported by another program.'''
         global w, w_win, rt
     rt = root
     w = Toplevel (root)
     top = New_Toplevel_1 (w)
     unknown_support.init(w, top, *args, **kwargs)
     return (w, top)






which is the entry point when ate GUI window is invoked from code
within the running application.  For instance, A secondary GUI such as
a progress bar is desired for some action triggered in the main
GUI. Notice that it does not call Tk() nor start a mainloop; you only
want one of those.  A big point is that the init function is passed a
variable argument list in the name of flexibility.  It is also passed
a pointer to the GUI window





Support Module


This module is home of the hand coded portion of the application.
Obviously, PAGE can only prepare a framework for the application. What
PAGE knows about are, (1) the linkage between the GUI module and the
support module, (2) the callback functions to be located in the
Support module, and (3) the Tk variables which are to be manipulated
in the support module.


For linkage between the modules is mainly the init function.










		def init(top, gui, *args, **kwargs):


		global w, top_level, root
w = gui
top_level = top
root = top





Here PAGE merely generates the bare minimum. It sets global variables
which refer to the root of the GUI window “root = top” and w which
points to the GUI window.  The latter allow the user to change
configuration of the GUI window and of widget contained in the
window. For instance if there is a button (Button1) in the GUI
window, the color may be changed anywhere in the support module simply
with the following code:


w.Button1.configure(color='red')






Also, if there is hierarchy of modules or routines flowing from the
support module, then the reference to the GUI window can be passed
along and manipulated.


The generated code for the callback functions is even simpler:


def callback():
    print('unknown_support.callback')
    sys.stdout.flush()






Code generated for the Tk variable kkkk looks like:


def set_Tk_var():
   # These are Tk variables used passed to Tkinter and must be
   # defined before the widgets using them are created.
   global kkkk
   kkkk = StringVar()






The code generated as above is so generated so that the GUI module and
the support module will be an executable pair.  That is, you can
execute the GUI module and see what it will look like even though you
have put in no additional application code. If the GUI invokes a
callback, say by a button select, the program will tell you that it
was invoked. No you have a leg up, go program.


Now lets say you go write a substantial body of application code, and
discover that you need an additional widget in the GUI module; what to
do?


First invoke PAGE with the project name, add the widget with all its
callbacks and Tk variables. Then generate Python code for the GUI
module just like before.  You sure do not want to rebuild the support
module anew and erase all of your hand code.  So when you tell PAGE to
generate your support module, it gives you the option of updating the
existing support module. If selected, PAGE will merely add skeletons
for the new callbacks and add the new Tk variables.  In addition, it
will backup the previous version of the modules in case of failure or
PAGE bugs. etc..  PAGE will keep backups five deep.
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